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This user guide is provided as a means to understand features in TRITON’s software.  The user interface 
presented in this guide is subject to change to accommodate software upgrades and revisions.  While every 
precaution has been taken to eliminate errors in this guide, TRITON assumes no responsibility for errors in this 
document.   

Users of this document are required to have a valid license and dongle for Perspective in order to activate the 
software.  TRITON hereby grants licensees of TRITON’s software the right to reproduce this document for 
internal use only.  
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Welcome to Triton Perspective! 

Triton Perspective™ is a new product line from Triton Imaging that takes advantage of the 

latest in software technologies including: multi-core parallel processing, indexed cache files, 

workflow wizards, XML project files, multi-resolution tiling, and dB-based rendering to 

develop products that are fast, accurate, efficient, easy to use, and that provide the tools 

necessary for a broad range of real-world marine applications. 

Perspective Map™, a GIS-based mapping package, forms the foundation of Perspective by 

integrating the Triton BathyOne™, MosaicOne™, TargetOne™, and SeaClass™ software 

modules into a cohesive suite capable of processing, fusing, and displaying sidescan and 

multibeam data.  Each module is controlled from the Perspective Map environment via 

common, embedded user-interface, tools, and displays.  Perspective Map displays the output 

from these modules as multi-layer, co-registered survey tracks, sidescan sonar images, 

bathymetry DTMs, target icons and images, and seabed classification areas and boundaries.  

These seafloor image data can be easily combined with other available geo-coded data such 

as S-57 electronic nautical charts, coastline maps, and satellite or other GeoTIFF imagery as 

required.  Output of individual and fused data products in standard formats for processing by 

third-party applications is supported. 

BathyOne™ will process raw multibeam data 

and combine it with vessel position, pitch, roll, 

heave, and heading; tides; sound velocity; draft; 

and other data to produce accurate corrected 

bathymetry grid files.   Total Propagated Error 

(TPE) of the gridded data is calculated and made 

available for review and display. Gridded results 

are displayed as layers in Perspective Map along 

with other survey data such as coastline vector maps, electronic charts, sidescan mosaics, etc.  

A variety of display options are provided for bathymetry layers, including profiling, color-

coding gridded data by depth, relief shading, and transparency adjustment. With these tools, 

comparing recently collected bathymetry with other sensor data and historical data sets is a 

simple and intuitive process.



 

   

iii | P a g e   Februa ry 2011 
 

MosaicOne™ makes the production of high quality 

geo-registered sidescan mosaics a simple process.  

Mosaic images of sidescan or multibeam backscatter 

data are created by simply dragging and dropping raw 

XTF data files into the Perspective Map multi-layer 

map view.  Processing options such as nadir delete, 

far range clipping, and single-channel select, coupled 

with a comprehensive set of navigation processing 

tools, result in superior quality mosaics suited to specific application needs and collection 

regimes. MosaicOne images are displayed in Perspective in correct registration with other 

survey data such as shaded or color-coded bathymetry, electronic nautical charts, coastline 

vector data, survey tracks, target icons, annotation, seabed classifications, etc.  Data fusion is 

facilitated by adjusting the transparency of mosaic images allowing visual comparison of 

sidescan features with underlying data elements.  Fine adjustments to line position are easily 

made with the new Move Line feature and high-resolution waterfall displays of sidescan data 

direct from source XTF files cab be invoked with point and click at any position on the 

mosaic. 

TargetOne™ is a collection of target 

processing tools that enable the acquisition and 

analysis of objects seen in the sidescan data.  

Targets are acquired with point and click on a 

sidescan mosaic displayed in Perspective Map 

or from the raw sidescan data viewed in 

Perspective's embedded waterfall viewer.  The 

TargetOne module displays target images and 

provides for a variety of image manipulation 

and measurement tools to facilitate object recognition and classification.  Target positions are 

recorded as icons displayed on the mosaic with easy access to any target by clicking on an 

icon of interest.  Object measurement tools are provided that exploit sonar parameters.  

Output of target information is in standard XML format to support processing by other 

applications. 
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SeaClass™ is an advanced seabed 

segmentation/classification module that 

automatically characterizes bottom types based 

on statistical properties of sidescan mosaics or 

multibeam backscatter imagery.  SeaClass is 

based on a multi-layer perceptron supervised 

neural network.  The classification procedure 

consists of two stages: a learning stage and a 

classification stage.  Training is accomplished 

by the operator selecting areas in the mosaic of differing bottom type (e.g. sand, rock, 

mud, etc.).  Training of the classifier neural network then proceeds thru an automated 

statistical analysis of the selected samples and a characterization of each type.  The 

following classification stage is a completely automated process where the entire mosaic 

image is segmented into the different classes. Results of the classification are displayed 

overlain on the mosaic image with each area colored or optionally with vector/line 

boundaries around each area.  Output from SeaClass can be the DXF boundary vectors or 

a GeoTIFF mosaic image with the displayed color-coded areas.  



 

   

v | P a g e   Februa ry 2011 
 

TABLE OF CONTENTS 

 

�����������	







































 


















































 


















































 




	� �

��
����
���
���
��� 	

















































 


















































 






















	� �

��
����	��	������	������������	






















 


















































 



































	�� �

���
�	��	��������	




































 


















































 














































	� �

��		��������	���������	





























 


















































 













































	� �

��� �� ���� � ������ � �	
��	� ����������������������������������������������������������������������������������������������������������������������������������� �
��������������	
����

������������������������������������������������������������������������������������������������������������������������ �������� �
��������������	
��������������������������������������������������������������������������������������������������������������������������������� ���� �
��������������	
���

������������������������������������������������������������������������������������������������������������������������ �������� �

��� �����
��
���� 	 ������� ���������������������������������������������������������������������������������������������������������������������������������������
 �
����������
���������������������������������������������������������������������������������������������������������������������������������������������������� �
������������������������������������������������������������������������������������������������������������������������������������������������������������ �
�������������������������������������������������������������������������������������������������������������������������������������������������������������� �� �
�������
���������������������������������������������������������������������������������������������������������������������������������������������� �������� �

��� �� ��	� 
 
		 ����������������������������������������������������������������������������������������������������������������������������������������������������������� �
���������� 

����
������������������������������������������������������������������������������������������������������������������������������ ����������! �
�������"��#��
����
����������������������������������������������������������������������������������������������������������������������������������� �$�
������%����������������������������������������������������������������������������������������������������������������������������������������������������� �
�������
������������������������������������������������������������������������������������������������������������������������������������������������� ��&�
����&�'���
������������������������������������������������������������������������������������������������������������������������������������������������ �� �
������(�)�*���
�������������������������������������������������������������������������������������������������������������������������������������������� �
������+,�*��
����������������������������������������������������������������������������������������������������������������������������������������������- �
����!�.��/*�
��	�0���������������������������������������������������������������������������������������������������������������������������� ���������� �

��� �� ��
��� � �
��
 ����������������������������������������������������������������������������������������������������������������������������������������������� �
��� �� ��� � �	� �������������������������������������������������������������������������������������������������������������������������������������������������������� �

��&����
)��*�#�
��	��"������'�������������������������������������������������������������������������������������������������������� ���������� �
��&�������
���
	������������������������������������������������������������������������������������������������������������������������������������������& �
��&�����1

,��
	����������������������������������������������������������������������������������������������������������������������������������������� � �

��		����	����������	

































 


















































 










































	�� �

��� �����

��� �������������������������������������������������������������������������������������������������������������������������������������������������������� �
������+,�
������"
	������������������������������������������������������������������������������������������������������������������������������������� - �
������+,�
���2�����
������������������������������������������������������������������������������������������������������������������������������ ������� �

��� �	 �
����	� � 	�
	�� �������������������������������������������������������������������������������������������������������������������������������������������� �
��� �� ���

� � 	
���� ���������������������������������������������������������������������������������������������������������������������������������������������� �

����������'����34�
�������������������������������������������������������������������������������������������������������������������������������� ������ �
������+,�*��
�5�
�����34�
�������������������������������������������������������������������������������������������������������������� �������������� �
������+,�*��
�.���"�5�
�����34�
��������������������������������������������������������������������������������������������������� ��������������! �
������6���0����34�
�������������������������������������������������������������������������������������������������������������������������������������� �$ �
����&�781�0����34�
�������������������������������������������������������������������������������������������������������������������������������� ��������&� �
������%��������34�
��������������������������������������������������������������������������������������������������������������������������������������& � �
������9������*������������������������������������������������������������������������������������������������������������������������������������������������� &� �

��� �� 
��	�
� � �
���� ����������������������������������������������������������������������������������������������������������������������������������������������� �
������(���9�
:��������������������������������������������������������������������������������������������������������������������������������������������� &� �
�����������9�
:�������������������������������������������������������������������������������������������������������������������������������������������� &&�
������%�)��9�
:�������������������������������������������������������������������������������������������������������������������������������������������� �&��
������9�
:����	�����
������������������������������������������������������������������������������������������������������������������������������� �����&� �
����&��
*����	
������������������������������������������������������������������������������������������������������������������������������������������&� �



 

   

vi | P a g e   Februa ry 2011 
 

������9�*��%�����������������������������������������������������������������������������������������������������������������������������������������������&! �
������;����9�
:������������������������������������������������������������������������������������������������������������������������������������ ���������&$�

��		�������	��������	


































 


















































 










































	�� �

��� �� 	

����� � �	
��	� �����������������������������������������������������������������������������������������������������������������������������������������
� �
��� �� 	�	
��� � 	

���� �������������������������������������������������������������������������������������������������������������������������������������������
� �
��� �� 	�� � 	

���� ��������������������������������������������������������������������������������������������������������������������������������������������������
� �
��� ���� �� 	

���� �������������������������������������������������������������������������������������������������������������������������������������������������
� �
��� �� 
��	�
���� � 	

���� ���������������������������������������������������������������������������������������������������������������������������������������
� �

��&���+,�
���9�
:����
��%�����*��������������������������������������������������������������������������������������������������������������� ������� �
��&���34�
���9�
:����
��������������������������������������������������������������������������������������������������������������������������� ���������� �
��&�������
,�9�
:����
�������������������������������������������������������������������������������������������������������������������������������� ��! �
��&�������
,�2���,�������������������������������������������������������������������������������������������������������������������������������������� � �

��
 �� ��
��
� � 	

���� ��������������������������������������������������������������������������������������������������������������������������������������������� �
��� �	 �
����	� � 	

���� �������������������������������������������������������������������������������������������������������������������������������������������� �

��		����������	





































 


















































 


















































 
	�� �

��� �� �����
���� 
 ��	� ��������������������������������������������������������������������������������������������������������������������������������������������
 �
��� �����

� � �����
���� 	 �
� ���������������������������������������������������������������������������������������������������������������������������������� �
��� �� �����
���� � 
��	������ � �
������ ����������������������������������������������������������������������������������������������������������������� �
��� �� �����
���� � ����
� � 	

���� ����������������������������������������������������������������������������������������������������������������������������� �
��� �� 
��	��� � �����
��� ����������������������������������������������������������������������������������������������������������������������������������������� �

��	���� ���	








































 


















































 


















































 

	!� �

��� �� �
�� � �	� � ����	 ������������������������������������������������������������������������������������������������������������������������������������������� �
��� �� 
	�
	� 	
����������������������������������������������������������������������������������������������������������������������������������������������������� �

&�����.��"
,���
�9�
������*���<��	������������������������������������������������������������������������������������������������������������! � �
&�����.��"
������<��	��)��)������������������������������������������������������������������������������������������������������������������� �!&�
&������"

��=�������.��"
���
��������������������������������������������������������������������������������������������������������������������! � �
&�����%������+������������������������������������������������������������������������������������������������������������������������������������ ��������!� �
&���&�5��		��*�
��%
��	��*��������������������������������������������������������������������������������������������������������������������������� !! �
&�����#�������
�����
�������������������������������������������������������������������������������������������������������������������������������� ����!$ �
&����� ���9�
������*��������������������������������������������������������������������������������������������������������������������������������� ���$� �
&���!�.��,�%��������
���������������������������������������������������������������������������������������������������������������������������������$& �
&���$�%'9�9�
������*�������������������������������������������������������������������������������������������������������������������������������������$� �
&����-���	�=%>����9�
������*����������������������������������������������������������������������������������������������������������������������� -- �

��� �� 	������ � ���� ������������������������������������������������������������������������������������������������������������������������������������������������� �
��� �� ��
� ��� �� ���� ������������������������������������������������������������������������������������������������������������������������������������������������ �
��� �� 	 �� 	
�	� 	
������������������������������������������������������������������������������������������������������������������������������������������������ �
��
 �� ���  ��	� �������������������������������������������������������������������������������������������������������������������������������������������������������� �
��� �� 	�	
� 	 �
	 �����������������������������������������������������������������������������������������������������������������������������������������������������
 �
��� �� 	���	 ���������������������������������������������������������������������������������������������������������������������������������������������������������� �
��� �� ��������
���� � �
���� ������������������������������������������������������������������������������������������������������������������������������������� �

&�$����
�
��%�����*���������������������������������������������������������������������������������������������������������������������������������� �����-! �
&�$���.��"
�?���
*��,���������������������������������������������������������������������������������������������������������������������������������� - �
&�$��� ������%"�	��*������������������������������������������������������������������������������������������������������������������������������������ ���� �
&�$���%���"�'������������������������������������������������������������������������������������������������������������������������������������������� �� �

���� ���
	
�
	
�
���� � �
���� ��������������������������������������������������������������������������������������������������������������������������������� �
&��-���.��"
�9�
������������������������������������������������������������������������������������������������������������������������������� ������������! �
&��-���.��"
�#@.�������������������������������������������������������������������������������������������������������������������������������������� �����- �
&��-���.��"
��"��*��2������
������������������������������������������������������������������������������������������������������������ ���������� �
&��-���.��"
�.���/��
,�����
�������������������������������������������������������������������������������������������������� ��������������������� �
&��-�&�.��"
�%������������������������������������������������������������������������������������������������������������������������ ��������������������& �

��	���������	








































 


















































 
















































	� �� �


�� �� ����� � �	� � ����	 ���������������������������������������������������������������������������������������������������������������������������������������
 �

�� �� 
	�
	� � ����� ������������������������������������������������������������������������������������������������������������������������������������������������ �



 

   

vii | P a g e   Februa ry 2011 
 

������%�	������9�
������*���<��	��������������������������������������������������������������������������������������������������������� ��������! �
�������
����������<��	��)��)��������������������������������������������������������������������������������������������������������� ���������$ �
�������"

��=��������
�������
����������������������������������������������������������������������������������������������������������������� $�
�������"

����
�����%�����*����������������������������������������������������������������������������������������������������������������������� �- �
����&�%�����=��	���+�������������������������������������������������������������������������������������������������������������������������������� �� �
�������"

��������%�����*������������������������������������������������������������������������������������������������������������������������������ �


�� �� 	 �� 	
�	� � ����� ������������������������������������������������������������������������������������������������������������������������������������������� �

�� �� ���  ��	� �������������������������������������������������������������������������������������������������������������������������������������������������������� �

�� �� �
�	� � 	�	�	
�
��� ���������������������������������������������������������������������������������������������������������������������������������������
 �

�
 �� ��	�  ��	 ������������������������������������������������������������������������������������������������������������������������������������������������������� �

�� �� 	���	�  ��	 ���������������������������������������������������������������������������������������������������������������������������������������������������� �

�� �� ��������
���� � �
���� ������������������������������������������������������������������������������������������������������������������������������������� �

��!����
�
��%�����*���������������������������������������������������������������������������������������������������������������������������������� ������$ �
��!����
�����?���
*��,������������������������������������������������������������������������������������������������������������������������������� �- �


�� �� �
	
����� � �	�	
 ������������������������������������������������������������������������������������������������������������������������������������������� �
��$��������������
	����������������������������������������������������������������������������������������������������������������������������������� �� �
��$���������������

���������������������������������������������������������������������������������������������������������������������������� ��������� �
��$����������������������
������������������������������������������������������������������������������������������������������������������� �����& �
��$��������������

������������������������������������������������������������������������������������������������������������������������������� ������ �
��$�&�����������+��
�,���
��2�����
��������������������������������������������������������������������������������������������� ����������������� �
��$���0����9��
���/�����
����������������������������������������������������������������������������������������������������������������� ������������! �
��$�����������������A����/����������������������������������������������������������������������������������������������������������������������� ����&- �


��� �� �
	
����� 
 ���� ������������������������������������������������������������������������������������������������������������������������������������������ �
���-���.
��
,�����/��*������������������������������������������������������������������������������������������������������������������������������ ��&� �
���-���%����� ��*���
������
�������������������������������������������������������������������������������������������������������������������� ��&&�
���-���%���	��
������
�������������������������������������������������������������������������������������������������������������������������������&� �
���-�������������?���
*��,��������������������������������������������������������������������������������������������������������������������� ����&� �
���-�&������������B�������������������������������������������������������������������������������������������������������������������������������������& ! �
���-��������������'5����������������������������������������������������������������������������������������������������������������������������������� &$�
���-����������������*�������������������������������������������������������������������������������������������������������������������������� ��������� �


��� ���
	
�
	
�
���� � �
���� �������������������������������������������������������������������������������������������������������������������������������
� �
�������%�	������.���/��
,�����
��������������������������������������������������������������������������������������������������������� ��������� �
�������%�	������%������������������������������������������������������������������������������������������������������������������������������� ��������� �
�������%�	�������
��������*������������������������������������������������������������������������������������������������������������������ �����& �
�������%�	������������������
������������������������������������������������������������������������������������������������������������ ������������� �

��	���������	







































 


















































 

















































	 ��� �

��� �
 �
�	
 � �	� � ����	 ��������������������������������������������������������������������������������������������������������������������������������������

 �
��� �
 �
�	
� � 	�	�
��� ������������������������������������������������������������������������������������������������������������������������������������������
� �

�������������������*��������������������������������������������������������������������������������������������������������������������������������� ���� �
����������'�������*�������������������������������������������������������������������������������������������������������������������������������� ���� �

��� �
 �
�	
 � �	� � ������
��� ���������������������������������������������������������������������������������������������������������������������������������
� �
���������*��������

���������������������������������������������������������������������������������������������������������������������������������� ! �
���������*���������������
���������������������������������������������������������������������������������������������������������������������� �$ �
���������*�������

��������������������������������������������������������������������������������������������������������������������������������� �� �

��� �
 �
�	
 � �	� � ����� ��������������������������������������������������������������������������������������������������������������������������������������� �
���������*���������	
�� �*�
��������������������������������������������������������������������������������������������������������������� ���� �

!�	����
���	









































 


















































 


















































 
	��� �

��� �� 	� � ����� � ����	 �������������������������������������������������������������������������������������������������������������������������������������������� �
��� �� 
	�
	� 
 
������� � 	
 ���������������������������������������������������������������������������������������������������������������������������������������� �
��� �� �

��� � ���������
��� ������������������������������������������������������������������������������������������������������������������������������������ �
��� �� 	�
��� � 	
� 
 
������ ��������������������������������������������������������������������������������������������������������������������������������������� �
��� �� ��
� � ���������
��� ������������������������������������������������������������������������������������������������������������������������������������������ �
��
 �! ����� � ���������
��� ��������������������������������������������������������������������������������������������������������������������������������������
 �

 



 

   

1 | P a g e   Februa ry 2011 
 

1:  Software Interface 

1.1 Main Window Overview 

1.1.1 Main Window Layout 

  

Main Window Layout 

 Map View  

The map displays all loaded layers.  It renders a composite view of all the 
data according to the settings of each layer. 

 Information Tabs 

This is a four tab window that displays information based on the current 
modality.  The tabs include cursor position information, measurement 
results, moved line offsets and contact/target information.   

 File Tree 

The Tree View displays all layers loaded into Perspective.  Each layer type 
has its own right-click menu for changing specific settings.  Data in the Tree 
View is rendered in the map by compositing the data from bottom to top. 

 Custom Cursor 

This allows the user to display cursor locations using a custom projection. 
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1.1.2 Main Window Menus 

File Menu 

New Project Create a new Perspective Project  

Open Project Open an existing Project (*.proj_xml) 

 Save Project Save your current project (* .proj_xml) 

Save Project As Save project with new name (*.proj_xml) 

 Import Primary import menu for recognized types.  Can also be 
accessed through standard windows drag and drop. 

Export Export Geo TIFF and KML files 

Page Setup Page setup for printing  

Print Print the current project  

Quit Quit Perspective 

Modality Menu  

Select Map Selection mode  

Measure Map Measure mode 

 Pan Map Pan mode 

Zoom Map Zoom mode 

Contact Generation TargetOne or XML Contact Mode 

SB Interpretation Sub-bottom Interpretation mode (not implemented yet) 

Classification Training SeaClass Classification mode 

Quick Classification Quick Classification mode  

Edit Classification Edit Classification mode 

 Annotation Annotation mode 

Bathy Profile Bathymetry Profiling mode 

Bathy Edit 3D Area Editor mode (not implemented yet) 



 

   

3 | P a g e   Februa ry 2011 
 

A – B A – B mode 

Digitize Lines and 
Polygons 

Digitization mode (not yet implemented) 

Display Depth-Scale Display Depth-Scale mode 

View Menu 

Toolbar Turn toolbar visibility  on/off  

Zoom In Zoom in on map 

Zoom Out Zoom out on map 

Zoom 1:1 Zoom to 1 meter/pixel 

Zoom Home Zoom to the extents of your survey area or saved home location 

Save As Home Save current viewport as Home 

Add Viewport Add current viewport to Region node in the file tree 

Globe Turn on ENC Globe rendering  

Settings Info Show settings dialog box 

Custom Cursor Change projection for custom cursor 

Log Window Show the log window 

Help Menu 

Contents Show help table of contents  

Licensing Show licensing dialog box 

 Sales Show sales dialog box 

About Show about dialog box 

Check for Updates Check for Perspective version updates (via web connection) 
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1.1.3 Main Window Toolbars 

Main Toolbar 

 

 Create a new Perspective project 

 Open Perspective project 

 Import raw data files 

 Import data from folder 

 Save current projection 

 Print 

 Application settings 

 Help 

Utility Toolbar 

 

 
Mosaic Wizard 

 
BathyPro Wizard 

 Line Merge 

 Spot Histogram 

 Refresh from database 
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Modality Toolbar 

 

 Select Mode 

 Pan Mode 

 Zoom Mode 

 Measure mode 

 Draw Mode 

 Bathy Profile Mode 

 Contact Mode 

 Sub-bottom interpretation 

 Bathy Area Edit mode - not yet implemented 

 
Digitize Lines and Polygons - not yet implemented 

 Classification training mode 

 Quick classification mode 

 Edit classification mode 

 Display Depth Scale 

 A-B 

Zoom Toolbar 

 

 Zoom in 

 Zoom out 

 Zoom 1 to 1 

 Zoom Home 
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1.2 Information Displays 

Perspective Map has four tab-controlled information displays in the upper left corner of the 
software window, located to the left of the Map View and above the File Tree.   

Cursor Tab:  This the default display, which shows the cursor position and the map. 

Measure Tab:  Shows the results of measurements made in the map view. 

Offset Tab:  Shows the amount a sidescan line has been moved for feature alignment. 

Contact Tab:  Indicates the target capture size and next target number. 

Custom Cursor:  In addition to the 4 tabs of information, there is another cursor information 
display below the File Tree for setting a custom cursor position display.   

For Custom Cursor Tab details go to Section 1.4. 

1.2.1 Cursor Tab 
The cursor display is where position values can be viewed dynamically as the cursor is 
moved across the Map View. 

The current project projection is displayed in gray at 
the top of this tab.  

North and East, Lat and Lon display the current 
cursor position in the Map View. It is updated as the 
cursor moves. 

The button beside 'Lat' and 'Lon' is used to change 
the format of latitude and longitude from 'degrees 
minutes decimal seconds' to 'degrees decimal 
minutes' to 'decimal degrees'. 

The button beside 'Depth' is used to change the depth value from meters to feet. 

The slider button is used to change the Map View resolution from meter/pixel to cm/pixel. 
Acts like a zoom. 

1.2.2 Measure Tab 

Selecting the 'Measure' toolbar button   in Perspective map will switch the information 
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display to the 'Measure' tab to show the results of measurements made in the map view.  

When using the 'Measure' tool, select a starting point on the map by left clicking on the spot 
and holding the button down while the distance to measure is spanned.  Once the end point is 
reached, release the mouse button.  The measurement results are displayed dynamically in the 
'Measure' tab.  Units are always in meters. 

The following image shows the results of the most recent measurement: 

Horiz. Dist.:  the distance covered by the 
measurement in the horizontal or "X" direction. 

Vert. Dist.:  the distance covered by the 
measurement in the vertical or "Y" direction. 

Distance:  the direct distance along the line drawn 
in Perspective Map. 

 

1.2.3 Offset Tab 
When a sidescan line is moved with the 'Move Line' 
function (see topic for move line), the amount the line 
was moved in order to align it with the rest of the 
mosaic is stored in the cache file. 

When a line is moved using the ‘Move Line’ tool, the 
amount the line was moved will be displayed in the 
‘Offset’ information tab as shown in the image to the 
right. 

For this line the total amount of displacement was 
7.93m, with the horizontal (X) displacement of 3.12m and vertical (Y) displacement of 
7.29m. 

1.2.4 Contact Tab 
Selecting the 'Contact Generation' toolbar button in 
Perspective map will switch the information display 
to the 'Contact' tab.  

Size (in meters) indicates the size of the screen 
capture to be made when a target is selected from 
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the Map View.   

Contact Number is the number to be assigned to the next target selected. 

Also shown is the 'Contacts Color Legend' to visually distinguish between the types of 
contacts displayed in the Map View. 

1.3 File Tree 

The file tree organizes project layers by 
grouping similar items.  The layers can be 
toggled on or off by clicking in the box next to 
the layer. A green check-mark appears next to 
the items in the map root that are displayed in 
the Map View.  The order the items are arranged 
in the map tree dictates the display order in the 
Map View. 

1.3.1 Map Root Layer 

Layers organized under the heading of Map 
Root include: 

·  Annotation 

·  SeaClass 

·  Contacts 

·  Vectors 

·  Navigation 

·  Imagery 

·  Background 

All layers in the File Tree can be toggled on/off by checking or un-checking the box next to 
the layer.  If a box is unchecked, all sub-layers will also be unchecked.  Conversely, by 

checking a box that is not already checked, all sub-layers will 
also be checked.   

The image above shows the basic File Tree structure and the 
check boxes for toggling the display of that layer: 

Right-clicking on ‘Map Root’ will bring up the following menu 
for user-defined controls of the map root dialog. 
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Selection Color:  Allows the user to identify the color which the selected line will change to, 
in order to identify it as being successfully selected in the map directory 

Collapse to Roots:  Quickly collapse the tree to the major headings.  A plus sign will be 
assigned in front of those headings which have additional data in their hierarchy.   

Expand All :  Allows the user to quickly expand all directories within the map root.  A 
negative sign will be assigned in front of those headings which are fully expanded. 

Open Project:  Allows the user to open a project from the tree diagram.  This has the same 
functionality as the “File > Open Project” pathway. 

New Project:  Allows the user to create a new project from the tree diagram.  This has the 
same functionality as the “File > New Project” pathway. 

Info :  Gives the user a “Window” on the Project File contents.  The project file has the file 
extension .proj xml and is an XML file.   Advanced users could edit this file directly using 
any XML file editor. 

1.3.2 The Annotation Tree 
This layer includes information that is user-defined in the Map View.  The annotation layer 
has three sub-layers: Regions, Grid, and User.   

The Regions layer provides one-click access to different preset map zoom levels that are 
commonly used for quickly navigating around the Map View.   

The Grid layer provides options for changing the projection grid color and resolution settings.   

Text and drawing annotations made by the user are stored in the User layer.   

1.3.2.1 Regions 

Regions are predefined zoom extents that 
are useful for quickly moving around in 
the map window.   

To add a region, zoom the map window 
to the area that is to be considered a 
region, right click on “Regions” and 
select ‘Add Viewport’ as shown below 

This is will give a user dialog window to 
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name the selected region.   

A dashed outline will appear in the Map View 
delineating the area as being selected.  The 
region name will appear as a node under the 
‘Regions’ layer node.   

Right-clicking on the region name gives the following options: 

 

Color Settings:  The user can change the color and characteristics of the outline, as well as 
color, opacity, thickness and character of the line.   

 

Rename:  The name of the region can be changed by selecting “Rename…”   

 

Move To Top, Move Up, Move Down:  Allows the used to move the region up and down 
within the region file tree node. 
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Remove:  The region can 
be removed by selecting 
“Remove…”  

Info :  Allows the user to 
view the datum/projection 
and coordinates of the 
region. 

1.3.2.2 Grid Overlay 
This is an overlay graph of the lines of 
Easting and Northing, which are 
automatically displayed in the Map View.  It 
can be modified in resolution and in color. 

Right-clicking on the ‘Grid’ layer will give 
the following options: 

Resolution:  Allows the user to change the resolution of the grid overlay to a user-defined 
distance. 

Color Settings:  Allows the user to change the 
color of the grid overlay. 

Info :  Allows the user to view the resolution, 
datum/projection and coordinates of the grid. 

1.3.2.3 User Annotation 
Drawing tools are available under the Modality > Annotation menu or by selecting the 'Pen' 
toolbar button.  When annotations are created using the drawing tools, they appear in the 
Annotation > User file tree menu. 

The following options are available by right-
clicking on the individual annotation: 

Color Settings:  Allows the user to change the 
characteristics of the annotation 

Rename:  Allows the user to rename the user-
defined annotation.   

Move To Top:  Moves the corresponding 
annotation to the top of the Tree View within 
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the ‘User’ heading. 

Move Up:  Moves the corresponding annotation above the previous annotation within the 
‘User’ heading. 

Move Down:  Moves the corresponding annotation below the successive annotation within 
the ‘User’ heading. 

Remove:  Allows the user to remove the annotation from the Map View and Tree View. 

Info:  Provides the projected position of the annotation. 

1.3.3 SeaClass Tree 
The SeaClass layer contains three sub-layers as shown in the image below: 

 

Manual Training  - where training data points are stored 

Neural Nets - for displaying the neural nets generated 
from the training data 

Classification - includes the results of the classification 
process 

 

Right-clicking on the Manual Training layer or any of its 
sub-layers will give the following options: 
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Color:   Available at the class file tree level.  Opens color dialog for changing the color of the 
sample point icons in the map view.   

Train Neural Net:   Initiates the second step in the classification process using the training 
set created.   

More information about the Neural Net training process is presented in Section 8.4. 

Edit Training Set:   Allows user to make changes to training sets by adding or deleting data 
points in a class (bottom type) or to add another class with new data points.   

More information about the Edit Training Set process is presented in Section 8.5. 

Resample:  This will resample the targeted image with the updated training set after edits are 
made. 

Remove:  Removes the selected layer from the project.  This is available at the training set 
layer and the class layer nodes. 

Remove All:  Removes all sub-layers from the current tree node.   

Export:   Allows users to save the SeaClass training set created.  SeaClass export options are 
described in Section 2.3.6. 

Create:  Launches the Create Training Set wizard as described in Section 8.2. 

Add:   Adds an existing training set to the project and Map View. 

Rename:  Allows users to rename an existing training set that is in the file tree. 

Info:   Allows the user to view XML info for the selected file. 

 

Right-clicking on the Neural Nets layer or any of its sub-layers will give the following 
options: 

 

Move to Top:  Moves the selected layer to the 
first position within the “Neural Nets” heading. 

Move Up:  Moves the selected layer above the 
previous file within the “Neural Nets” heading. 

Move Down:  Moves the selected layer below 
the succeeding file with the “Neural Nets” 
heading. 

Add:   Adds an existing neural net to the project and Map View. 
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Remove:  Removes the selected layer from the project.   

Remove All:  Removes all sub-layers from the current tree 
node.   

Rename:  Allows users to rename an existing neural net that 
is in the file tree. 

 

Edit Color:   Opens color dialog for changing the color of the 
neural net class.   

Right-clicking on the Classification layer or any of its sub-
layers will give the following options: 

 

Color Settings:  Opens following window for changing background color, opacity, and line 
drawing settings. 

 

Move to Top:  Moves the selected layer to the first position within the “Classification” 
heading. 
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Move Up:  Moves the selected layer above the previous file within the “Classification” 
heading. 

Move Down:  Moves the selected layer below the succeeding file with the “Classification” 
heading. 

Export:   This will export the classification results to an AutoCAD DXF file.  �

Add:   Adds an existing classification grid to the project and Map View. 

Remove:  Removes the selected layer from the project.   

Info:   Allows the user to view XML info for the selected file. 

Zoom to Extents:  Quick zoom option to zoom to full extent of selected mosaic. 

1.3.4 Contacts Tree 
The Contacts layer contains the contacts and targets identified and saved with TargetOne.  
Contacts classified as targets show up as a different color which can be defined by the user. 

Right-clicking on the ‘Contacts’ layer will give the following options: 

Sort Ascending:  Sorts the ‘Contacts’ in the project by 
name in ascending order in the file tree.   

Sort Descending:  Sorts the ‘Contacts’ in the project by 
name in descending order in the file tree.   

Add:   Adds a saved contact to the project and Map View. 

Info:   Allows the user to view the file location, 
datum/projection and coordinates of the contact file. 

Right-clicking on the region name gives the following options: 

Add:   Adds a saved contact to the project and Map View. 

Remove:  This will remove a contact from the project.  
Please note that this will not delete the contact from the 
hard drive, only remove it from the project and Map View. 

Viewer:  Selecting this option opens the contact in 
TargetOne. 

Info:   Allows the user to view the file location, 
datum/projection and coordinates of the contact file. 
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1.3.5 Vectors Tree 
Vector files can be imported in DXF format (Autocad R12 DXF only).  Right-clicking on 
‘Vector’ will give the user the following options. 

 

If no vector files are currently available, the user can click on ‘Add’ to insert a file.  This will 
open a browser window that will be searching for a file in the DXF file format.   

 

After selecting the DXF file to be imported into the Map View, the user will define the 
projection and datum for the file.  Projection and Datum standards are available for selection, 
or user defined projections can be set by selecting ‘Custom’.   

Right-clicking on a vector file that has been imported into Perspective provides the following 
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options: 

Rename:  Allows the user to rename the vector file in the Tree 
View.  This does not change the name of the file, only the 
reference name within Perspective Tree View. 

 

Remove:  Allows the user to remove individual vector files 
from the map tree and Map View.   

Move to Top:  Moves the individual vector file to the first 
position within the ‘Vector’ heading. 

Move Up:  Moves the individual vector file above the previous file within the ‘Vector’ 
heading. 

Move Down:  Moves the individual vector file below the succeeding file with the 
‘Vector’ heading. 

Info:   Allows the user to view the projection and file path directory of the vector file. 

1.3.6 Navigation Tree 

This file tree layer is where the navigation for the various files are kept and organized.  The 
main sources of navigation available in this heading are: 

·  Sidescan - navigation for sidescan data imported from raw data file 

·  Multibeam - navigation for multibeam data imported from raw data file 

·  Singlebeam - navigation for singlebeam data imported from raw data file 

·  Subbottom - navigation for subbottom data imported from raw data file 

·  Vessel - vessel navigation imported from raw data file 

The navigation data automatically populate these sub-tree layers depending on the type of 
data present in the import file. There is an additional node in the Navigation tree called 
Viewer.   

When viewing the raw data of an imported file, the line name will appear under the Viewer 
node.  This applies to sidescan data in the waterfall window and multibeam data in the swath 
viewer.  
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There are no right-click options on the Navigation tree node but sub-layers have the 
following options: 

Reset Navigation:  Allows the user to return the navigation 
to its original position as interpreted from the data file.  
Selecting this option from right-clicking on a mosaic file 
will reset the navigation for all XTF files in the mosaic.  
Right-clicking on a single XTF will only reset the 
navigation for the selected file and file type. 

View:  This option is available on the XTF layer level and 
will open a waterfall viewer for sidescan navigation and a 
swath viewer for multibeam navigation. 

More information on the Waterfall Viewer and Swath 
Viewer can be found at Sections 5.9 and 5.9.4. 

Sort Ascending:  Sorts the data files by name in ascending 
alphanumeric order. 

Sort Descending:  Sorts the data files by name in descending alphanumeric order. 

Add:  Allows the user to add data files. 

Remove:  Allows the user to remove all navigation for a particular line from the Map View.  
It will remove the navigation line from the Multibeam, Sidescan and Vessel nodes. 

Info :  Access XML settings file for viewing the projection, file path directory of the vector 
file, ping range in viewer window, and other information. 

Zoom to Extents:  Quick zoom option which zooms to the full extent of the navigation data 
for Multibeam, Sidescan and Vessel nodes. 

1.3.6.1 Color Settings 
Selecting this will open the following window: 

 



 

   

19 | P a g e   Februa ry 2011 
 

Options include: 

·  Color - click on colored box and select new color from 'Color' window 

·  Opacity - slider bar for changing transparency level 

·  Line Drawing - line thickness can be changed by selecting left drop-down menu, line 
style can be changed be selecting the right drop-down menu.  Line style options 
include: 

 

Color Settings are available for all navigation sub-layers. 

1.3.6.2 Show BeamLines 
This is only available for sidescan data by right-clicking on the individual lines.  By selecting 
this option, the swath lines for each ping are displayed in the Map View as shown below: 

 

The line selected is highlighted in light blue and the individual swath lines indicate the swath 
coverage for that line. 
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1.3.6.3 Navigation Viewer 
This option is available at all tree levels in the 
Navigation.  When the raw data from any Navigation 
tree layer is being viewed, the line name will appear 
under the ‘Viewer’ node.  Currently this is only 
enabled for the sidescan waterfall window and the 
multibeam swath viewer.  The example shown below 
is for a sidescan line:   

As shown in the ‘Viewer’ 
node in the Navigation file 
tree, the line being viewed 
is 071-1809.  This is 
confirmed in the waterfall 
window title bar as shown 
to the right. 

1.3.7 Imagery Tree 
This file tree layer is where the imagery data is kept and organized.  There are five types of 
imagery supported: 

·  Footprint Time Series 

·  Sidescan  

·  Bathymetry 

·  Bathymetry TIN 

·  Bathymetry TPE 

1.3.7.1 Sidescan & Footprint Time Series 
Sidescan Node:  The sidescan imagery file tree layer is where the mosaic files that are 
imported or created from raw data are managed.  The following options are available by 
right-clicking on the sidescan node. 

Move to Top:  Allows the user to move the Sidescan imagery to the top of the tree within 
the Imagery node. 

Move Up:  Allows the user to move the Sidescan imagery to above the previous imagery 
within the Imagery node. 

Move Down:  Allows the user to move the Sidescan imagery to below the successive 
imagery within the Imagery node. 
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Export to GeoTiff:  Allows the user to export the imagery to a geotiff imagery file. 

Batch Export to GeoTiff:  Allows the user to export all sidescan mosaics in the file tree 
to a geotiff imagery files.   

Export KML:  Allows the user to export a Google Earth KML file.  

Create:  Allows the user to create a new mosaic layer using any of the existing raw data 
files in the project.  A new layer name is specified, then the parameters for the new layer 
are processed and finally the user can choose which lines to include. 

Add:  Allows the user to add other mosaic files to an 
existing project. 

Info:  Access XML settings file for viewing the 
projection, resolution, file path directory of the 
sidescan data, plus other information. 

Mosaic Node:  The following options are available by 
right-clicking on the individual mosaic layer under the 
sidescan node. 

Color Settings:  Allows the user to change the color 
characteristics of the sidescan layer.   

Histogram:  This is the graphical representation of the 
imagery signal level in dB versus the occurrence of 
that dB within the image.   

Move to Top:  Moves the selected image file to the 
top of the Tree View within the Imagery > Sidescan 
layer.  The image file listed on top (or first) within the 
Tree View will be displayed on top of all other image 
files of similar type. 

Move Up:  Moves the selected image file above the 
previous sidescan image file in the Tree View.  The 
image files will be displayed in the order listed within 
the Tree View. 

Move Down:  Moves the image file below the successive sidescan imagery file.  The 
image files will be displayed in the order listed within the Tree View. 

Mosaic Settings:  Opens the Mosaic Wizard so that the user can make changes to mosaic 
settings used to create the imagery.  More information about the MosaicOne Wizard can 
be found at section 6.2.   
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Re-merge Mosaic:  Applies user corrections and line changes to the mosaic. 

Export GeoTiff:  Exports a GeoTiff of the selected sidescan mosaic file.   

Export KML:  Exports a KML file of the selected sidescan mosaic file(s).   

Classify:  Classifies the selected sidescan mosaic file.  Details on using the sediment 
classification tool in Perspective are available in section 8.3.  

Blink Comparator:  Toggles a sidescan layer on and off at a set cycle rate to get a visual 
comparison of the same location in two different sidescan layers or mapping events.   

 

Statistics:  This gives an overview of the data used to create the image.  Included in the 
statistics window are the following: 

·  Allocated Coverage:  This is the number of square nautical miles which the tiles used 
to store the data in the DTM or MOZ file represent.   

·  Actual Coverage:  This is the number of square meters of the actual ensonified area.   

·  Total Lines:  This is the number of lines included and used in the creation of the 
mosaic file 

·  Along-Track Distance:  This is the combined along-track distance of all lines included 
and used in the creation of the mosaic file.  

Add Lines:  Allows the user to add other raw data files in the project to the mosaic. 

Remove:  Allows the user to remove the imagery from the Map View.  Perspective will 
prompt the user to confirm before removing the imagery. 

Delete:  This action removes the imagery file from the project and deletes the mosaic file 
that was created on import.  Perspective will ask for confirmation before deleting the 
imagery from the disk. 

Info:  Access XML settings file for viewing the projection, resolution, file path directory 
of the mosaic file, plus other information. 

Zoom to Extents:  Quick zoom option to zoom to full extent of selected mosaic. 

Sidescan Data File:  The following options are available by right-clicking on the individual 
sidescan data files under the mosaic node. 

Geo-Reference (GRL) Settings:  Opens the 
Mosaic Wizard and allows changes to be 
made to the Line Settings page.   
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Force Regeneration:  Rebuilds the mosaic using the current settings. 

View Waterfall:  This option is available on the XTF layer level and will open a 
waterfall viewer.   

Move Line:  This option allows the user to move an individual line of sidescan data to 
align features on adjacent lines in the mosaic.   

Remove:  Allows the user to remove the data file from the DTM.  Perspective will 
prompt the user to confirm before removing the selected file. 

1.3.7.2 Bathymetry, TIN & TPE 
The bathymetry imagery file tree layer is where the DTM files that are imported or created 
from raw data are managed.   

Bathymetry Node:  The options shown in this image are 
available by right-clicking on the Bathymetry node. 

Color Settings:  Allows the user to change the color 
characteristics of the bathymetry imagery.  Changing 
the settings at this level affects the color settings for all 
bathymetry layers.   

Histogram:  This is the graphical representation of the 
imagery signal level in dB versus the occurrence of that 
dB within the image.  Changing the settings at this 
level affects the histogram for all bathymetry layers.   

Relief Shading:  This tool simulates the illumination 
of the sun on the bathymetry data.  This is a global 
setting and can only be changed at this node level. 

Move to Top:  Allows the user to move the 
Bathymetry imagery to the top of the tree within the 
Imagery node. 

Move Up:  Allows the user to move the Bathymetry 
imagery to above the previous imagery within the 
Imagery node. 

Move Down:  Allows the user to move the Bathymetry 
imagery to below the successive imagery within the 
Imagery node. 

Sort by:  Allows the user to sort Bathymetry layers by either Name or Date. 
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Export to GeoTiff:  Allows the user to export the imagery to a geotiff imagery file.   

Batch Export to GeoTiff:  Allows the user to export all bathymetry DTMs in the file tree 
to geotiff imagery files.   

Export KML:  Allows the user to export a Google Earth KML file.   

Create:  Allows the user to create a new DTM layer using any of the existing raw data 
files in the project.  A new layer name is specified, then the parameters for the new layer 
are processed and finally the user can choose which lines to include. 

Add:  Allows the user to add other mosaic files to an existing project. 

Info:  Access XML settings file for viewing the projection, resolution, file path directory 
of the bathymetry data, and other information. 

DTM Node:  The options shown in the image to the right are available by right-clicking on 
the individual ‘DTM’ layer under the Bathymetry node. 

Color Settings:  Allows the user to change the color characteristics of the bathymetry 
layer.   

Histogram:  This is the graphical representation of the imagery signal level in dB versus 
the occurrence of that dB within the image.   

Move to Top:  Moves the selected image file to the top of the Tree View within the 
Imagery > Bathymetry layer.  The image file listed on top (or first) within the Tree View 
will be display on top of all other image files of similar type. 

Move Up:  Moves the selected image file above the previous bathymetry image file in the 
Tree View.  The image files will be displayed in the order listed within the Tree View. 
Move Down:  Moves the image file below the successive bathymetry imagery file.  The 
image files will be displayed in the order listed within the Tree View. 

Sort by:  Allows the user to sort Bathymetry layers by either Name or Date. 

Rebuild Using:  Upon selecting this option, the user is asked if they want to use the GSF 
flags already present in the GSF.  The Bathy Wizard then opens to allow the user to make 
changes to bathymetry settings used to create the imagery and apply any edits/flags made 
to the GSF file.    

For more information about the Rebuild Using tool, visit Section 5.3. 

Edit GSF Using:  Upon selecting this option, the Bathy Wizard opens so that the user 
can apply any edits/flags made to the GSF file.   

For more information about the Edit GSF tool, visit Section 5.4. 
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Re-merge DTM:  Applies user corrections and line changes to the DTM. 

For more information about the Re-Merge DTM tool, visit Section 5.5. 

Batch Export to GeoTiff:  Allows the user to export all bathymetry DTMs in the file tree 
to GeoTiff imagery files.   

Export KML:  Exports a KML file of the selected bathymetry DTM file(s).   

Export XYZ:  Allows the user to export the selected bathymetry DTM in the file tree to 
an ASCII XYZ file.   

A-B:  Subtracts co-registered DTMs to look for changes to bathymetry.  This algorithm 
does a direct pixel to pixel comparison at each grid node.   

For more information about the Bathy A-B tool, visit Section 5.10.2. 

Blink Comparator:  Toggles a sidescan layer on and off at a set cycle rate to get a visual 
comparison of the same location in two different sidescan layers or mapping events.   

 

Change Detection:  Subtracts co-registered DTMs to look for changes to bathymetry.  
This algorithm differs slightly from the A-B algorithm in that it also includes a statistical 
neighborhood approach to account for mis-registration between layers.  Operating the 
Change Detection tool is the same as the A-B tool. 

Statistics:  This gives an overview of the data used to create the image.  Included in the 
statistics window are the following: 

·  Allocated Coverage:  This is the number of square nautical miles which the tiles used 
to store the data in the DTM file represent.   

·  Actual Coverage:  This is the number of square meters of the actual ensonified area.   

·  Total Lines:  This is the number of lines included and used in the creation of the 
mosaic file 

·  Along-Track Distance:  This is the combined along-track distance of all lines included 
and used in the creation of the mosaic file.  

Add Lines:  Allows the user to add other raw data files in the project to the DTM. 
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Remove:  Allows the user to remove the imagery from the Map View.  Perspective will 
prompt the user to confirm before removing the imagery. 

Reset Date:  Provides the ability to change the date of the DTM file. 

Delete:  This action removes the imagery file from the project and deletes the DTM file 
that was created on import.  Perspective will ask for confirmation before deleting the 
imagery from the disk. 

Info:  Access XML settings file for viewing the projection, resolution, file path directory 
of the DTM file, and other information. 

Zoom to Extents:  Quick zoom option which zooms to the full extent of the selected 
DTM. 

Bathy Data File:  The following options are available by right-clicking on the individual 
bathymetry data files under the ‘DTM’ node. 

Remove:  Allows the user to remove the data file from 
the DTM.  Perspective will prompt the user to confirm 
before removing the selected file. 

View Swath:  This option is available on the XTF layer level and will open a swath 
viewer to view the multi-beam data by swath.   

View GSF History:  This option is available on the XTF layer level and will indicate 
what processing steps have been performed on the GSF file. 

1.3.8 Background File Tree 

This is where the background data is stored and organized within the Tree View.   

There are two types of files that are used for background images:   

��  GeoTiff 

��  ENC Charts 

1.3.8.1 Background GeoTiff Data 
To bring a background GeoTiff into the project, you can either right-click on the layer node in 
the file tree: 

Background > GeoTiff Data  
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or the window menu option: 

File > Import > GeoTIFF File. 

Both options will open a file browser to locate a GeoTiff.   

 

Once selected the projection for the image will need to be defined if this was not previously 
set in the Projections Tab for the Application Settings or for a previous background import.  
Perspective will remember your import projection after the first image is imported so the user 
will not need to repeat the projection wizard for every background file.   

GeoTiff Data Node Options:  By right-clicking on the GeoTiff Data node, the following 
options exist: 

Color Settings:  Allows the user to change the color 
characteristics of the GeoTiff layer. 

Add:  Allows the user to add other GeoTiff files to an existing 
project. 

Info:  Access XML settings file for viewing the projection, 
resolution, file path directory of the background data, and other 
information. 

Zoom to Extents:  Quick zoom option which zooms to the full 
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extent of selected GeoTiff. 

GeoTiff Options:  Right-click on the imported GeoTiff, for the following options: 

Color Settings:  Allows the user to change the color characteristics of the GeoTiff layer.�

Projection:  Allows the user to change the GeoTiff projection. 

Tag Info:  Displays the GeoTiff world file information as shown below: 

 

Remove:  Removes the selected GeoTiff file from the project. 

Info:  Access the XML settings file for viewing the projection, resolution, file path 
directory of the background data, and other information. 

Zoom to Extents:  Quick zoom option which zooms to the full extent of selected 
GeoTiff. 

1.3.8.2 Background ENC Charts 
To bring a background S57 ENC (Electronic Nautical Chart) into the project, you can either 
right-click on the Layer node in the file tree and select ‘Add’ 

Background > ENC Data or the window menu option  File > Import > ENC (S57) File. 

Both options will open the ENC Search 
window.  

Pressing the Import button will open a file 
browser to locate a S57 .000 or .7cb file. 

 

 

 



 

   

29 | P a g e   Februa ry 2011 
 

 

Once selected, the ENC will be imported into Perspective.  It will then be displayed in the 
Map View and added to the Background > ENC Data layer in the File Tree. 

 

ENC Data Node Options:  By right-clicking on the ENC Data node, the following options 
exist: 

Add:  Allows the user to add other S57 ENC files to an existing project. 
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Info:  Access XML settings file for viewing information about the ENCs in the node. 

ENC Options:  Right-click on the imported ENC, for the following option: 

Info:  Access XML settings file for viewing information about the ENC. 

 

Display settings for ENC data files can be found in Program Settings in Section 3.4. 

1.4 Custom Cursor 

In addition to the 'Cursor' tab which displays the cursor position in both projected and un-
projected coordinates, the cursor position can be displayed in another coordinate system in 
the Custom Cursor display located below the File Tree. 

 

The elongated button beside 'Lat' and 'Lon' is used to change the format to either a preset or a 
custom format.  Clicking this button starts the ‘Select Custom Projection’ wizard as shown 
below. 
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In this example we set the ‘Custom Cursor’ to a Transverse Mercator projection.  To enter a 
custom projection, select the 'Custom' button in the window to launch the 'Custom Projection 
Tool'.   

For Custom Projection details go to Section 3.5.3. 

The projection parameters can be entered here. 

�
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Select the datum here or the 'Custom' button to setup a custom datum. 

 

For Custom Datum details go to Section 3.5.4. 

1.5 Map View 

1.5.1 Moving Around the Map View 
There are two methods for navigating the Map View.  These are: 

��  Zoom Tools 

��  Pan Tool 

Zoom - There are several available zoom options including: 

·  Zoom Mode 

·  Zoom In 

·  Zoom Out 

·  Zoom 1:1 

·  Zoom Home 
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·  Zoom to Region 

·  Zoom to Extents 

Pan - This mode allows the user to move around the screen by dragging the map.   

1.5.1.1 Zoom Mode 

Selecting the zoom toolbar button    
puts the cursor in Zoom Mode.   

This allows the user to select an area to 
zoom into by left-clicking or right-
clicking on any point on the map and 
holding the button down while defining 
an area to zoom into.   

 

 

 

1.5.1.2 Zoom In 
This will zoom in one level and is accessed by the following options 

·  ToolBar Icon  

·  View menu option 

·  Keyboard 'Page Down' or '+' key   

1.5.1.3 Zoom Out 
This will zoom out one level and is accessed by the following options 

·  ToolBar Icon  

·  View menu option 

·  Keyboard 'Page Up' or '-' key  

1.5.1.4 Zoom 1:1 
This will zoom such that 1 meter is equivalent to 1 pixel on the computer screen and is 
accessed by the following options 
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·  ToolBar Icon  

·  View menu option 

·  Keyboard 'End' key 

1.5.1.5 Zoom Home 
This will zoom to Home which by default is the full extent of the data but can be manually 
set to any zoom with the 'Save As Home' option in the View menu.  Zoom Home is accessed 
by the following options 

·  ToolBar Icon  

·  View menu option 

·  Keyboard 'Home' key  

1.5.1.6 Zoom to Region 
This option is only available by selecting the desired Region in the Annotation file tree as 
shown in the example below: 

  

By clicking on 'Region 0' in the file tree, the Map View will automatically zoom to that 
region (shown as a yellow dashed box in image). 
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1.5.1.7 Zoom to Extents 
This option is available by right-clicking on select nodes within the File Tree.  Selecting this 
will zoom the Map View to the full extent of the chosen data. 

1.5.1.8 Pan Mode 
This mode allows for moving around the data at a particular zoom level by dragging the 
screen with the cursor.   

Select the pan/zoom icon    and then left-click and drag the screen with the button 
depressed. 

When the mouse button is released, the view will redraw at the new location.  Pan mode is 
discussed more in section 1.5.2.3.  

To exit this mode, another mode button must be selected, such as the Select mode button 

1.5.2 Cursor Modes 

There are several cursor modes available through the toolbar buttons and menu options.  
These are: 

��  Select Mode�

��  Measure Mode�

��  Pan Mode�

��  Zoom Mode�

��  Contact Generation / Targeting Mode�

��  Classification Modes  �

·  Classification Training 

·  Edit Classification 

·  Quick Classification 

��  Annotation Mode�

	�  Bathymetry Profiling Mode 


�  A-B Mode  
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���  Depth Scale Mode  

The cursor modes are described in detail in the following sections. 

1.5.2.1 Select Mode 

This option is available when the pointer toolbar button  is selected.  It is the default mode 
and is used for selecting items in the map view. 

1.5.2.2 Measure Mode 

Selecting the 'Measure' toolbar button    in Perspective map will switch the cursor to the 
Measure mode for making measurements of features seen in the Map View.   

When using the 'Measure' tool, select a starting point on the map by left clicking on the spot 
and hold the button down while the distance to measure is spanned.  Once the end point is 
reached, release the mouse button.   

The following window shows how the measured line appears in the map window with the 
distance annotated on the line.  Also shown are the results of the measurements in the 
Measure information tab.  For Measure Tab details go to Section: 1.2.2. 
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1.5.2.3 Pan Mode 
This mode allows the user to center the screen over a particular object for using the ‘Zoom-
In’ and ‘Zoom-Out’ options, and also is good for following a pipeline or route while zoomed 
in where the full extent of the feature following does not fit entirely in the display. 

Select the pan icon    and then click and drag the screen with the button depressed. 

1.5.2.4 Zoom Mode 

Selecting the zoom toolbar button    puts the cursor in Zoom Mode.   

This allows the user to select an area to zoom into by left-clicking or right-clicking on any 
point on the map and holding the button down while defining an area to zoom to.   

When the mouse button is released, the map will zoom into the selected area. To zoom back 
out, use the toolbar buttons for zooming out or returning to the home zoom. 

The image below is an example of the selection process: 

 

When the mouse button is released the screen will redraw to the selected extents. 
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1.5.2.5 User Annotation Mode  

Drawing tools are available under the Modality > Annotation 
menu or by selecting the 'Pen' toolbar button.  When selected, an 
annotations window will appear as shown below: 

All user annotations placed in the Map View from this dialog 
will appear as items under the Annotation > User heading in the 
file tree. Various shapes and text options are available.   

Options include: 

 

 
 

Ellipse: Dimensions are determined by clicking and dragging to the desired size 

 
 

Rectangle: Dimensions are determined by clicking and dragging to the desired size  

 
 

Triangle: Dimensions are determined by clicking and dragging to the desired size 

 
 

Polygon: Dimensions are determined by clicking and dragging to the desired size  

 
Fixed size Ellipse: Dimensions of the annotation are entered by the user prior to 
insertion of the character on the map.  

 

 
 

Fixed size Rectangle: Dimensions of the annotation are entered by the user prior to 
insertion of the character on the map.  

 
 

Text: A text box used to mark and describe features on the map. 
 

 

 

Common Annotation Tools 

 

After selecting an annotation mode, the user may preselect the annotations attributes from 
this same dialog.  
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The color, opacity, thickness and character of the annotation line are defined by 
clicking on the paint palette.  

The color of the icon is the current color selected for the annotation and will 
remain the default color until changed in this attribute box. 

 
The font attributes of text annotation are selected by clicking on the letter icon. 

 
The symbols can be hollow or filled by clicking on the corresponding icon. 

Object attributes can be set at the time of creation, or later by right-clicking on the layer in 
the file tree structure. 

Annotations can be turned on and off from the map display from the file tree.  More 
information about annotation options from the file tree is presented in Section 1.3.2.3. 

1.5.2.6 Bathymetry Profiling 

Selecting the 'Bathy Profile' toolbar button    in Perspective map will switch the cursor to 
the Profile mode for evaluating features seen in the Map View.   

Select a starting point on the map by left clicking on the spot and holding the button down 
while the profile line is spanned.  Once the end point is reached, release the mouse button.  
The Bathy Profile tool is described in detail in the BathyOne section of this user manual. 

1.5.2.7 Contact Generation 

Selecting the 'Contact Generation' option    in the Modality menu or selecting the toolbar 
button in Perspective map will switch the cursor to the Contact Generation mode for marking 
locations of interest seen in the Map View.  Selecting this toolbar will automatically launch 
TargetOne for analyzing and saving the selected target.   

1.5.2.8 Classification  

Bottom types can be classified in MosaicOne using the built-in classification module called 
SeaClass.  The classification process is described in detail in Section 8.3. 

1.5.2.9 A-B Mode 

Selecting the 'A-B' toolbar button  in Perspective Map or the 'A-B' option in the 'Modality' 
menu will switch the cursor to the A-B mode for determining differences in DTM layers seen 
in the Map View.  
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Select a starting point on the map by left clicking on the spot and holding the button down 
while the area to be used for the A-B calculation is defined.  A box will be drawn in the 
screen defining the area and when done, release the mouse button to start the calculation. The 
'A-B' tool is described in detail in the BathyOne part of the Help guide in Section 5.10.2. 

1.5.2.10 Display Depth Scale Mode 

This option is available when there is a DTM layer in the project.  To display the depth scale, 
first select a DTM layer from the file tree by clicking on it once.   

The depth scale is then launched by either selecting the 'Display Depth-Scale' 
option in the Modality menu or by clicking on the toolbar button shown below 

 

This will open the following depth scale window shown to the right which can 
be moved around in the window or placed anywhere on your desktop. 

 

2:  Data Management 

2.1 Importing 

2.1.1 Import Methods 

The toolbar offers three methods to bring data into Perspective. 

This will open a window browser to import selected raw data files into the project as 
shown in the image below: 
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This button will import all compatible data file in a selected 
folder. (NOT YET IMPLEMENTED) 

This button will use the database search function to remove all data in a project and 
load only the data that lies within a selected time range or a defined geographic area.   

Currently the only raw survey data format supported by Perspective is the Triton XTF data 
format.  However, there are several existing Triton file format converters to allow importing 
of additional data types.   

In addition to raw data files, Perspective can import a variety of data types including Triton 
mosaic and DTM files, GeoTiffs, XYZ files, GSF files, AutoCAD DXF files, and a few 
various others.  Data types supported and methods for importing each data type are described 
in the following sections. 

2.1.2 Import Data Types 

All data types can be imported from the Import option in the File menu or directly from the 
File Tree by selecting ‘Add’ from the right click menu: 

·  SeaClass layers 

·  Contacts 

·  Vectors 

·  Navigation layers 
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·  Imagery layers 

·  Background layers 

The Import option found in the File menu allows the ability to import all compatible data 
types into Perspective.  The options available are shown in the menu window below: 

Raw Data File:  Selecting this option from the 
File>Import menu will open a window browser for 
selecting compatible raw data files for import into the 
project.  Currently XTF is the only raw data file type 
supported.  Selecting raw data for import will 
automatically launch the processing wizard for sidescan 
and/or bathymetry depending on the contents of the 
imported file. 

Mosaic File:  Selecting this option will allow users to 
import mosaic files previously generated in Perspective. 

ENC (S57) File:  Allows users to import S57 charts for 
background project imagery. 

GeoTIFF File:  This option imports selected GeoTiff 
files into the project for use as background imagery. 

Contact File:  Allows the user to import contacts or 
target files generated with TargetOne. 

TritonMap File :  Mosaic files created with TritonMap can be imported using this option. 

Vector File:  Supported AutoCAD DXF files can be imported with this option. 

Neural Net:  This option allows users to import a neural net created in Triton’s SeaClass 
module for sediment classification.   

Classification File:  Sediment classification results can be imported using this option. 

Symbol:  Selecting the 'Symbol' option found in the File > Import menu will open the 
following window: 
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This window allows the user to set the name, category, size and transparent color of the 
symbol.  To load a symbol into this window, select the 'Load' button which will open the 
file browser below to select the symbol file.  Navigate to a compatible file type and select 
'Open'.  This will automatically insert the symbol image into the Symbol Importer 
window.  Selecting ‘OK’ will load the symbol into the project.  

ASCII XYZ Grid File :  Selecting an ASCII XYZ file to import will launch the XYZ Grid 
Parsing window as shown below: 

 

Options and displays include: 

·  Data Field:  The data in the XYZ file is shown in the box at the top of the window.   
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·  Line:  If there was a header, the box next to ‘Line’ is for entering the number of 
lines to skip for the header, before the data begins. 

·  Delimiters:  This is where the data delimiters are defined.  In the example above 
the data is separated by spaces and therefore the ‘Space’ box is checked. 

·  Parsed Field:  Displays data elements available for mapping to predefined field 
types. 

·  Field:  Predefined field types to assign data to. 

·  Format:  Set the units or format of the data value assigned to this field. 

·  Attribute:  Can attribute the defined field as a header or as a data value. 

·  Update:  The user must select this after the parsed field has been applied to a field 
and the format has been selected to complete the decoding process for that data 
type. 

·  Decoded Data Element:  Displays the results of data to field mapping. 

·  Decoded Header Element:  Displays the results of header to field mapping 

For this example, the first data column is for Easting, the second is for Northing, and the 
third is for depth.  The parsing window shown on the previous page was captured after 
the data had been mapped to the appropriate fields with the decoded data elements 
indicating which Field and Format was applied to each element. 

Select ‘OK’ when finished.  This will launch the BathyOne Wizard to create a bathymetry 
layer. 

ASCII Singlebeam File:  This will import singlebeam data from an XYZ or TXT file.  
Selecting this option will launch the Singlebeam ASCII Parsing window (identical to the 
XYZ Grid Parsing window). 

Bathy DTM File :  Selecting this option will allow users to import DTM files previously 
generated in Perspective. 

GSF File:  This option allows users to import GSF files into Perspective.  Selecting GSF File 
import will automatically launch the BathyOne Wizard to create a bathymetry layer. 

2.2 Database Refresh 
An alternative method for importing mosaic and DTM files created from Perspective is to use 
the Database Refresh toolbar button shown below: 
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The database refresh tool gives the user the option to import files into the project, based on 
either time or location.  It is important to note that instead of just being an import tool, the 
database refresh tool also removes layers from your project that do not meet the search 
criteria.   

Database settings need to be defined prior to using this toolbar button to setup the data 
directory and to setup the query parameters.   

To use this tool, zoom into a region of interest in Perspective Map and select the Database 
Refresh toolbar button.  This will open the following window: 

 

The search parameters shown were copied from the Database settings tab, but can be changed 
here for quick access to the search parameters.   

Using the parameters shown above, selecting ‘OK’ will clear the project window and load the 
mosaic and DTM files (all layers selected) in the project folder that intersect the viewport and 
was collected since May 1, 2009. 

Selecting the checkbox in the lower left corner will not open this window upon selecting the 
Database Refresh toolbar button and instead will use the search criteria entered in the 
Database settings tab. 

2.3 Export Methods 
There are a few options for exporting data from Perspective Map.  Export file types include: 

·  GeoTiff file 
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·  KML file 

·  XYZ file 

Layers visible in the Map View can be exported as a GeoTiff by using the Composite 
GeoTiff export menu option.  Right-clicking on the File Tree layers offers additional export 
options  

Printing the Map View is similar to selecting Composite GeoTiff Export from the File menu 
but also includes annotations and allows the user to save the map View as a PDF (with Adobe 
Acrobat) or send the map View to a printer for a hard copy of the project.   

Export options are discussed in detail in the following sections. 

2.3.1 Map View Export 
Exporting the Map View to a GeoTiff will create a geo-referenced TIFF that includes all the 
layers selected in the File Tree.   

Selecting 'File > Export > Composite GeoTiff' will open the following window: 

 

Options available in this window include: 

·  Resolution:  Sets the output file resolution in meters/pixel.  The size of the output file 
in pixels will show next to Dimensions, just below the resolution. 
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·  Tiles/Export:  The slider bar below the Dimensions is for indicating the number of 
tiles to break up the export image in order to reduce the individual file size of the 
output.  The image above shows the output divided into 16 tiles with resulting 
dimensions of each tile being 1097 x 992 pixels. 

·  Selection Tree:  Allows the user to select or deselect additional imagery to be 
included in the export. 

Selecting the Export button will open the following window for saving the file: 

 

2.3.2 Imagery GeoTiff Export 

Sidescan and bathymetry data can be exported from an existing project from the File Tree to 
a geo-referenced TIFF file.  For sidescan data, the GeoTiff Exporter is launched from either 
the sidescan root node or the individual sidescan layer.  Individual GeoTiff files for 
bathymetry are only exported from right-clicking on the Bathymetry root layer node. 

All options launch the same export wizard.  For sidescan exports, only sidescan data is 
available for inclusion in the export.  For bathymetry exports, only bathymetry data is 
available for inclusion in the export as shown in the image on the following page: 
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Options available in this window include: 

·  Resolution:  Sets the output file resolution in meters/pixel.  The size of the output file 
in pixels will show next to Dimensions, just below the resolution. 

·  Tiles/Export:  The slider bar below Dimensions is for indicating the number of tiles to 
break up the export image, in order to reduce the individual file size of the output.  
The image above shows the output in only 1 tile with resulting dimensions of each tile 
being 4096 x 3703 pixels. 

·  Selection Tree:  Allows the user to select or deselect imagery for the export. 

Selecting the Export button will open the ‘Save GeoTIFF’ browser window for selecting a 
location and file name for the export. 

2.3.3 Imagery Batch GeoTiff Export 

Sidescan and bathymetry data can be exported from an existing project from the File Tree.   

·  For sidescan data, the Batch GeoTiff Export window is launched from the sidescan 
root node only.   

·  For bathymetry, the Batch Export GeoTiff is available from right-clicking on either 
the Bathymetry root layer node or on an individual DTM as shown: 
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There are no settings to change in this window and default export options are automatically 
applied.  To complete the export, select the green 'Play' button in the upper left corner of the 
window.  The files are exported to the default project folder and the results are shown in the 
output window as seen in the image below: 

 

2.3.4 KML File Export 

Sidescan and bathymetry data can be exported from an existing project from the File Tree to 
a Google Earth KML file.  For sidescan and bathymetry data, the ‘KML Exporter’ is 
launched from either the sidescan/bathymetry root node or the individual mosaic/DTM layer.  
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All options launch the same export wizard.  For bathymetry exports, only bathymetry data is 
available for inclusion in the export.  For sidescan exports, only sidescan data is available to 
be included in the export as shown below: 

 

Options available in this window include: 

·  Resolution:  Sets the output file resolution in meters/pixel.  The size of the output file 
in pixels will show next to Dimensions, just below the resolution. 

·  Range:  Sets the default zoom range above the Earth for opening the file with Google 
Earth. 

·  Tiles/Export:  The slider bar below Dimensions is for indicating the number of tiles to 
break up the export image, in order to reduce the individual file size of the output.  
The image above shows the output in 48 tiles with resulting dimensions of each tile 
being 256 x 231 pixels. 

·  Checkbox:  Automatically launch Google Earth and insert the exported KML file for 
viewing at the distance above ground specified above. 

·  Selection Tree:  Allows the user to select or deselect imagery for the export. 

Selecting the Export button will open the ‘Save KML’ browser window for selecting a 
location and file name for the export. 

If the checkbox was selected, then Google Earth will automatically launch and open the 
exported file.  Please note that Google Earth needs to be installed on your computer for the 
auto-launch feature to work. 
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2.3.5 XYZ File Export 
Bathymetry data can be exported from an existing project from the File Tree to a text .xyz 
file.  This can only be launched from right-clicking the bathymetry ‘DTM’ layer.  

This will launch the Export XYZ wizard shown below: 

 

Options available in this window include: 

·  Resolution:  Sets the output file resolution in meters/pixel.  The cell size can be set to 
maintain a 1:1 aspect or the X and Y size can be set individually. 

·  Projection:  Allows the user to set the export projection.  Information on the 
Projection Wizard and Projection Settings can be found in Section 3.5. 

Selecting the ‘Save’ button will open the following window for saving the file: 
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2.3.6 SeaClass Export 
Results from the classification process can be exported through the following methods: 

1. Composite Export:  This will export all layers turned on in the file tree including the 
SeaClass results as a composite GeoTiff file.  �

2. Manual Training Export :  This exports the training sets to an XML file and is launched 
by right-clicking on the Training Set file tree layer and selecting Export as shown below: 

 

This opens the file save dialog window shown below: 
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3. Classification Export:  This exports the classification grid to an AutoCAD DXF file 
which is launched by right-clicking on the classification grid tree layer and selecting 
Export as shown below: 

 

This opens the file save dialog window shown below: 
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2.3.7 Printing 
In order to print the Map View to a PDF file (you will need Adobe Acrobat for this) or to a 
printer, select ‘Print’ from the File menu.  This will open a standard Windows printing 
window as shown below: 

 

Select ‘Print’ to output the Map View to the chosen printer. 

2.4 Project Options 

2.4.1 New Project 
To create a new project, select the ‘New Project’ option from the File menu as shown below: 

 

 

Selecting this will open a new project.  If an existing 
project is open and not already saved, the user will be 
asked to save the project. 
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2.4.2 Open Project 
To open an existing project, select the ‘Open Project’ option from the File menu as shown 
below: 

 

Selecting this will open the following window: 
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2.4.3 Save Project 
To save an existing project, select the ‘Save Project’ option from the File menu as shown 
below left: 

             

To save a new project select the ‘Save Project As’ option from the File menu as shown above 
right. 

Selecting this will open the following window: 
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2.4.4 Projected Cursor 
The Project Cursor option is available from the View menu as shown below: 

- 

Selecting this will add the ‘Custom Cursor’ display to the main 
window as shown to the right.   

The Custom Cursor is discussed in detail in Section 1.4. 

 

2.4.5 Log Window 

To log the project activities, select the ‘Log 
Window’ option in the View menu as shown 
right: 

Selecting this will open a new window with a 
record of the activities since the project was 
opened.  Additional actions will automatically 
record in this window to document workflow 
steps.   

 

 

 

An example of the Log Window is shown left: 
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2.4.6 Page Setup 
Page Setup options are available from the File menu as shown below: 

 

Selecting this will open the Page Setup window as shown below: 
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2.4.7 Quit Project 
When finished working on a project, the project can be closed by selecting ‘Quit’ from the 
File menu as shown below: 

 

Selecting this will prompt the user with the following dialog box: 
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3:  Program Settings  

3.1 Settings Overview 
Application settings can be accessed 

through the toolbar button    or by 
selecting Settings Info from the View menu 
as shown below: 

There are up to six tabs available in the 
Program Settings window, two of which 
require additional licensing. 

·  General 

·  Pen 

·  ENC (requires S57 license/dongle) 

·  Projection 

·  Contact 

·  Database (requires additional database license) 

3.2 General Settings 

Scratch Path:  This is the directory 
where temporary Perspective files are 
kept.  Select the button to the right of the 
file path to change to a new scratch 
location. 

Optimize GeoTiffs:  This will speed 
up viewing large GeoTiffs by 
indexing a copy of the file in the 
scratch folder, than accessing it from 
the scratch folder. This indexing 
allows Perspective to only load part 
of the GeoTiff when needed rather 
than the whole GeoTiff file. 

Number of Cores:  This is where the 
user tells Perspective how many (if any) 
of the cores the host computer is utilizing.  This helps to optimize Perspective processing. 
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Options: 

Ask before removing layers:  This allows the user to turn on or off the message, "Are you 
sure you want to remove...", that pops up when "Remove" is selected in the File Tree. 

Show Mosaic Tiles:  This lets the user see the tiles that the mosaic is divided into. 

Load Zoom Out:  Selecting this option will automatically zoom to the full extent of an 
imported layer. 

Relative Paths:  Allows the project to be relocated to a new hard drive without losing 
track of the relative file paths of imported files. 

Hide Mouse Over ToolTips:  Hides the display of the cursor when over pop-up tooltips. 

Auto Update:  Checking this box will allow Perspective to look for any updates to the 
Perspective software on the Triton Imaging Inc. website each time Perspective is opened. 

Auto Save:  Perspective will automatically save the project every user defined interval while 
it’s running. 

Cache Options: 

Force Cache Rebuild:  When a survey file is opened in Perspective it is cached or 
"indexed" and an .xtf_idx file is created. This allows Perspective to access an XTF file in 
a non-linear fashion which significantly speeds up the processing once the .xtf_idx file is 
created. The first time a survey file is read, the xtf_idx file is created and it takes a little 
longer to load the file, once the idx file is created “Forcing a cache rebuild” forces this 
xtf_idx file to be recreated. 

Use Ensemble X/Y (SEG-Y):  Some SEG-Y have the data "stacked" and the navigation 
stored in a different place, checking this box identifies the file as this type. 

Suppress Warnings:  These are warnings that come from indexing a file when building 
the cache. For example "10 pings had no navigation". If you do not want to have these 
warning pop up then click the box to "suppress warnings".   

Sync Views:   

For a data file that contains bathymetry and sidescan data, the ‘Sync View’ option allows the 
user to sync the playback of the waterfall viewer and swath viewer by ping number. 

Reset Factory Settings: 

This will reset the Program Settings to the default factory settings. 
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3.3 Pen Settings 
Intersection:  Allows the user to 
change the color Perspective assigns to 
sub bottom intersections. 

Background:  Allows the user to 
change the color of the Map View 
background.  

Profile Font:  Allows the user to 
change the color of the profile font in 
SB-I (not yet implemented). 

Zoom Tool:  Allows the user to change 
the color of the zoom box. 

Measure Tool:  Allows the user to 
change the color of the measuring line 
used by the measure tool. 

3.4 ENC Settings 

The way that ENC charts are displayed 
in Perspective can be controlled from 
the ENC tab on the Settings dialog.  
Note that this tab will only appear if 
you have an S-57 license and 
corresponding dongle plugged in. 

Paths:  These file paths need to be set 
in order to access the ENC data. 

Color Scheme:  There are four options 
to select from for changing the ENC 
palette. 

Lookup Table:  This setting controls 
of the amount of items that are included 
in the display of the ENC.  The 
simplified option yields an ENC with 
fewer items and less clutter. 

The ‘Advanced’ button will invoke the 
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Advanced ENC Settings window. 

From this window, the attributes that 
are included in the display of the 
ENC can be selected and the 
parameters associated with each 
attribute can be specified (in meters).   

The Color Intensity slider allows the 
adjustment of the brightness of the 
ENC in the Map Display to be 
adjusted. 

3.5 Projection Settings 

These are the five separate projection settings available in the Projections tab. 

·  XTF Import Projection 

·  GeoTiff Import Projection 

·  ASCII XYZ Projection 

·  Contact Save Projection 

·  Export Projection 
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There are also two check boxes in the Projections tab, related to import and export 
projections. 

Auto set Export Projection to UTM/WGS84:  As specified, this requires that the input files 
are in latitude and longitude coordinates.  Checking this box will export the data in the same 
projection as displayed in the Map View. 

Ask to use current import projection:  This will prompt the user during the file import process 
and ask whether to use the current projection.  If the current projection is not satisfactory, an 
import projection wizard will launch. 

3.5.1 Import Projection Settings 

The import projection wizard is identical for the XTF, GeoTiff, XYZ, and Contact projection 
settings.   

The default import projection is un-projected latitude and longitude in WGS84.  When the 
first file is loaded into a new project, the import projection wizard will launch and the 
projection can be set at that time.   

Alternatively, the user can preset the import projection using the Program Settings option 
described below. 

Selecting 'Change' under any of the top four options in the Projections tab of the Program 
Settings will launch the import projection wizard shown below: 

 

On this page, select the projection to use.  If a custom projection is needed, select the 
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‘Custom’ button.  For Custom Projection details, see Section: 3.5.3. 

Press the ‘Next’ button to select additional projection information.  For this example the 
correct UTM zone, hemisphere, and units need to be specified. 

 

Select the datum to use.  If a custom datum is needed, select the ‘Custom’ button.  For 
Custom Datum details, see Section: 3.5.4. 

 

Select Finish when done. 
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3.5.2 Export Projection 
The export projection wizard is basically identical to the import projection wizard except for 
the name in the title bar.   

The default projection for exporting files is un-projected latitude and longitude in WGS84.  If 
the 'Auto set Export Projection to UTM/WGS84' box is checked, Perspective will 
automatically assign a UTM zone based on WGS84 coordinates. 

Selecting 'Change' under Export Projection in the Projections tab of the Program Settings will 
launch the following projection wizard: 

 

On this page, select the projection to use.  If a custom projection is needed, select the 
‘Custom’ button.   

Press the ‘Next’ button to select additional projection information.  For this example the 
correct UTM zone, hemisphere, and units need to be specified. 
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�

Select the datum to use.  If a custom datum is needed, select the ‘Custom’ button.  

 

Select ‘Finish’ when done. 
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3.5.3 Custom Projection 
To define a custom projection, select 'Custom' from the Select Projection page of the import 
or export projection wizards as shown below: 

 

This will open the following window: 

 

Select ‘Create’ to start the Projection Definition window. 
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Enter the appropriate information for the projection to be defined.   

Below is an example with random test data: 

 

To generate the information in the lower left window, select the ‘Generate String’ button.  
Select ‘Done’ once the projection string has been generated. 

This returns the user to the original window, with the projection string generated in the 
previous window now entered automatically in the Projection String box. 
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Enter a name to save the projection to and select ‘OK’. 

This returns the user to the Select Projection window.  Choose the new projection just created 
from the projection list and select ‘Finish’ or ‘Finish and Save’ to keep the custom projection 
for future projects. 
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3.5.4 Custom Datum 
To define a custom datum, select 'Custom' from the Choose Datum page of the import or 
export projection wizards as shown below: 

 

This will open the following window: 
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Select an existing ellipsoid or choose custom from the list as shown below: 

 

Enter the appropriate information for the projection to be defined and a ‘Save As’ name and 
select ‘OK’ when done. 

The Choose Datum window now has the custom datum listed at the bottom. 
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Select the new datum just created from the projection list and select ‘Finish’ or ‘Finish and 
Save’ to keep the custom datum for future projects. 

Selecting ‘Finish and Save’ will open the following window to save the datum: 

 

Enter a name for the datum and select ‘OK’. 
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3.6 Contact Settings 
Size (meters):  This is where the user selects the size of the contact to be saved, in meters. 

Bookmarks:  The user can select whether or not to show bookmarks in the Waterfall view. 

Targeting Paths: It is recommended that the user choose the same directory paths for 
Perspective and TargetOne. If both programs use the same directory paths, contacts that are 
saved in TargetOne will automatically be displayed in Perspective. 

Temporary:  The user can select where to have TargetOne keep contacts until they are saved. 

Saved:  The user can select 
where to have TargetOne 
save contacts once they have 
been temporarily saved in 
TargetOne.  Note that this 
needs to be different from 
temp directory. 

Note that the temporary and 
saved file paths must be 
different.  

Contact Usage:  The contact 
generated from Perspective 
can either be sent to 
TargetOne or to an XML 
file. Contacts sent to 
TargetOne will have the 
Triton Imaging Inc .CON file 
format.  

A contact generated as XML 
contains the parameters 
required to queue external programs to areas of interest within the mosaic. Included in the 
XML structure is a link to a geo-referenced TIFF file (.tif + .tfw) that is the snapshot from the 
Perspective Mosaic.  

XML contacts can contain links to other types of imagery such as AUV mounted optical 
cameras.  

Threshold: 

Use Target One setting:  Set the default display threshold using the TargetOne settings. 

Calculate from data:  Set the display threshold by calculating the value from the data file. 
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Current Contact Number:  Indicates the contact number that will be given to the next 
contact generated. 

3.7 Database Settings 
On:  Check this box to turn on the auto-load database option. 

Database Path:  Sets the file path to the project database folder. 

Date Selection Options:   

Recent:  The user can select the number of days back from the current date by using the Days 
Back number list. 

Since Date:  The user can select a range of time using the Start Date field to enter a start date 
and using the current date for the End date. 

Range:  The user can select a range of time using the ‘Start Date’ field to enter a start date 
and the ‘End Date’ field for the end date. 

Always ask before 
search:  This check box 
will prompt the user for a 
date option when selecting 
‘Refresh to View’. 

Use Refined Database 
Query when Viewport is 
less than:  User enters a 
value for using the refined 
database query for small 
Viewports.   

This is useful for reducing 
the data that is nearby but 
not in the map view from 
loading into the project by 
reducing the size of the 
layers’ bounding box. 
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4:  Navigation  

4.1 Navigation Types 
Navigation embedded in raw data files is extracted upon import of the data file and sorted 
into 5 main categories.   

The main types of navigation in Perspective are: 

·  Sidescan - navigation for sidescan data imported from raw data files 

·  Multibeam - navigation for multibeam data imported from raw data files 

·  Singlebeam - navigation for singlebeam data imported from raw data files 

·  Subbottom - navigation for subbottom data imported from raw data files 

·  Vessel - vessel navigation imported from raw data files 

If multiple data types are available in one raw data file, importing that one data file can 
populate multiple navigation data fields in the file tree.  If for example the data file comes 
from a Reson 8101 which collects both sidescan and multibeam data simultaneously, 
importing one raw data file will populate the Sidescan navigation node, the Multibeam 
navigation node and the Vessel navigation node as shown in the image below: 

 

Note that importing one data file, BRDG001 in this example, populated the multibeam, 
sidescan and vessel layer nodes in the navigation file tree.  Each navigation type has its own 
color so they can be distinguished in the map view.  These are kept separate since the user 
may wish to process the navigation differently for sidescan data than for multibeam. 
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4.2 Import Navigation Data 
Navigation data that Perspective works with comes embedded in raw survey data files and do 
not exist as stand-alone files.  Currently, the only raw survey data format supported by 
Perspective is the XTF format and the navigation data must be stored within the XTF file for 
Perspective to read and process it.   

Navigation data extracted from the raw data files are automatically separated and sorted into 
the navigation data types available in the navigation file tree section.  The navigation File 
Tree structure has several options for changing the way the navigation lines appear in the 
Map View and several ways to change processing and zoom options.   

For Navigation Tree details, see Section: 1.3.6. 

In addition to importing raw data files from the methods described in the Import Methods 
section, navigation data can be added directly from the File Tree by right-clicking on any of 
the navigation layer nodes and selecting 'Add'.  An example is shown below: 

 

Selecting this option will bring in all the data from the selected raw file, including the 
navigation data, and launch the processing wizard. 

Selecting a navigation line in the File Tree will also highlight that navigation line in the Map 
View display as a thicker light blue line as shown on the next page: 
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The image above shows two multibeam navigation lines, the thicker blue line is currently 
selected in the navigation file tree layer and the red line is currently not selected. 

When importing raw data files into Perspective, the import/processing wizard automatically 
launches.  While the wizard does give the option to process the navigation for the data type 
being imported, multiple stages of navigation processing cannot be accomplished before the 
wizard completes the mosaic or DTM creation using the partially processed navigation data.  
If there is reason to believe that the navigation data needs cleanup (poor satellite coverage, 
ROV/AUV tracking, etc.), then it is best to skip the creation of the mosaics or DTMs at this 
stage and process the navigation completely first.   

Navigation processing is an important step to obtaining clean results and some thought 
should go into what parameters to use and what level of processing is necessary for the 
collected data.  For example, hull or pole mounted systems tend to have a cleaner position 
signal and require less processing than towed sonar or ROV/AUV surveys. 

Presented in the next section are a couple possible workflows a user could follow for 
processing their navigation data. 
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4.3 Navigation Processing Workflows 
For surveys with hull-mounted equipment and good position control, very little processing is 
needed of the navigation data.  One pass is generally enough to remove small spikes in the 
navigation data.  This can be accomplished using the import/processing wizard, which only 
allows one pass at the navigation processing.  However, for towed sonar or data collected 
from ROVs or AUVs generally more processing is needed to create imagery which 
accurately reflects the true vessel position at the time of the ping transmission and reception. 

Currently there are two primary workflows for processing navigation data. 

��  Process on import:  Upon importing raw survey data files, the processing wizards 
each have a button for setting the navigation processing settings.  These settings are 
made and then applied when the data is being processed for creating mosaics or 
DTMs.   

These settings are only applied once to the raw navigation data.  Towed sidescan 
often needs repeatable navigation smoothing and is not adequately processed with this 
method.   

Navigation processing boxcar settings are described in detail in the next section of 
this manual, Section 4.4. 

��  Process from File Tree:  Upon import of the raw survey data, the processing wizards 
are skipped and only the navigation lines are imported.  Then the navigation can be 
processed using the Process Navigation window, which allows for multiple passes 
over the navigation data.  This is often necessary for towed sonar or data collected 
from ROVs or AUVs.   

To repeat the navigation processing, first setup the Boxcar filter to use either 'Ship' or 
'Sensor' as the source navigation.  Click 'Start' in the Process Navigation window to 
initiate the processing.  When complete, return to the Boxcar Settings and change the 
navigation source to 'Smoothed'.  This is a critical step, otherwise the processing will 
continue to use the same raw source navigation.   

Details of the Process Navigation window are presented in Section 4.5  
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4.4 Navigation Boxcar Settings 
Selecting the Filter Setup button in the Process Navigation window opens the following 
Boxcar Settings window for setting processing parameters: 

 

General: 

- Window - sets boxcar window size 
- Source - sets source navigation 

·  Sensor - Uses the position found in the XTF sensor navigation 

·  Ship - Uses the position found in the XTF ship navigation 

·  Smoothed - Uses the smoothed position already in the cache file, (uses the previously 
smoothed navigation from the last processing) 
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Heading: 

- Compute CMG - Check the box to compute a heading from the Course Made Good 
(navigation) 

- Bias - Apply a single bias to the computed CMG heading 

- Change Cutoff - Cutoff value for CMG calculation (in degrees) 

Layback: 

- Source 

·  None - Do not apply a layback 

·  Computed - Computes a layback using the values found in the XTF file for Cable Out, 
Towfish Depth, Towpoint Height, and Towpoint offset from the navigation antenna 

·  Manual - Enter a fixed layback value (in meters) 

- Tow Point Offsets - Applies the user-defined values in crossbeam direction.  

- Time Delay - Static time delay (in seconds) 

Offsets: 

- Applies user - Defined value in X, Y relative to position.  

·  +X equals Starboard, -X equals Port 

Speed: 

- Filter Speed - Turns the option on 

·  Min - Enter the minimum expected speed 

·  Max - Enter the maximum expected speed 

·  Change Cutoff - Cutoff value for speed filter (in knots) 

Compute: 

·  Never - Use the speed from the XTF file 

·  Always - Ignore existing speed and re-compute 

·  When Zero - Only computes speed if the value in the file is zero 

Mag Heading Deviation: 

- On - Turns the option on 

- 0, 90, 180, 270:  Enter the corrected heading for each of cardinal compass points.  The 
mosaic engine will generate a smoothed correction curve interpolating between these values. 
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4.5 Process Navigation 
For processing navigation from the File Tree, select the ‘Process Navigation’ option available 
by right-clicking on any tree level in the Navigation layer.  Selecting this will launch the 
Process Navigation window shown below: 

 

Options include: 

·  Filter Setup - See 'Boxcar Settings' in the previous section of this manual. 

·  Auto Update Cache - Writes the processed navigation into the cache file, important 
for repeat processing. 

·  Check Intersections - Checks navigation at line intersections. 

·  Start - Click after Boxcar Settings have been made to initiate processing.  This can be 
clicked as many times as the user wants to repeat the navigation processing.  Please 
note that to process the results from the previous navigation processing step the 
navigation source must be changed to 'Smoothed'.  This will use the processed 
navigation in the cache file as the source allowing for multiple steps of processing. 

·  Cancel Processing - Cancels the current processing step, does not remove saved 
processed navigation from the cache file. 

·  Save and Exit - Saves processing to cache file if not already done with the auto update 
option, then exits processing wizard. 
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5: BathyOne  

5.1 BathyOne Module 
BathyOne is an add-on to Perspective Map which allows users to create digital terrain models 
of their raw bathymetry data and includes tools for viewing and interpolating the gridded 
data.  Options available in the BathyOne module are presented below; details of their options 
and settings are described later in this chapter. 

Grid Options 

Create DTM:  BathyOne provides a few methods for the creation of digital terrain models 
(DTM's).   

Rebuild Using:  Upon selecting this option, the user is asked if they want to use the GSF flags 
already present in the GSF.  The BathyOne Wizard then opens to allow the user to 
make changes to bathymetry settings used to create the imagery and apply any 
edits/flags made to the GSF file.   

Edit GSF Using:  This option is only available if a GSF File was imported without a 
corresponding raw data file using the 'Import/GSF File' option.  Selecting this option 
will launch a limited version of the BathyOne Wizard to allow the user to change 
some of the processing parameters set during the GSF import process.  

Swath Editor:  Not yet implemented. 

Re-merge DTM:  Will re-create the DTM based on any changes to the processing parameters 
or edits to the data made since the DTM was created.   

Add Lines:  Allows the user to add other raw data files in the project to the DTM.   

Reset Date:  Provides the ability to change the date of the DTM file.   

Rename:  Allows the user to rename the DTM name in the project.  This will not rename the 
file on the disc and only changes the display name in the Perspective Map project.   

Visualization Options 

Color Settings:  Allows the user to change the color characteristics of the bathymetry layer.   

Histogram:  This is the graphical representation of the imagery signal level in dB versus the 
occurrence of that dB within the image.   

Relief Shading:  This tool simulates the illumination of the sun on the bathymetry data.  This 
is a global setting and can only be changed at this node level.   

View Swath:  This tool allows the user to see the swath data from an individual data file.   
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Interpretation Options 

Bathy Profile:  Selecting the 'Bathy Profile' option from the toolbar button or Modality menu 
in Perspective Map will switch the cursor to the Profile mode for evaluating features 
seen in the Map View.     

A-B:  Subtracts co-registered DTMs to look for changes to bathymetry.  This algorithm does 
a direct pixel to pixel comparison at each grid node.   

Change Detection:  Subtracts co-registered DTMs to look for changes to bathymetry.  This 
algorithm differs slightly from the A-B algorithm in that it also includes a statistical 
neighborhood approach to account for mis-registration between layers.  Operating the 
Change Detection tool is basically the same as the A-B tool. 

Blink Comparator:  Visual comparison of two overlapping layers is made easy with this tool.  
The 'Blink Comparator' allows the user to quickly turn on/off a layer or can be set to 
cycle a layer on/off to help identify differences in the layers.   

Statistics:  This gives an overview of the data used to create the image including coverage 
and line statistics.   

5.2 Create DTM  

5.2.1 Bathymetry Processing Wizard 

Bathymetry data can be processed in Perspective Map using the BathyOne Wizard.  
Presented below are a few ways to launch the bathymetry processing wizard.   

During the raw data import process, the navigation data loads into the project first.  If the raw 
data files contain bathymetry data then the BathyOne Wizard will automatically launch and 
the bathymetry data can be processed as part of the import process. 

However if the navigation data needs repeat processing, the BathyOne Wizard can be 
canceled during the import process and re-launched after the navigation data is properly 
processed. 

For more information regarding Navigation Processing Workflows, visit Section 4.3. 

 
There are two methods to launch the BathyOne Wizard manually from within Perspective 
Map, from the File Tree and using the toolbar button. 

��       To launch the wizard from the File Tree, right-click on the Imagery/Bathymetry node and 
select 'Create' as shown below: 
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��       The processing wizard also can be launch by selecting the 'Create DTM' toolbar button:   

 

 
Whether the processing wizard is automatically or manually launched as described above, the 
same options are available.  Processing steps in the BathyOne Wizard are presented in the 
next Section.   

 
 

5.2.2 BathyOne Wizard Overview 

There are several steps the BathyOne Wizard guides the user through.  Brief descriptions of 
each step are presented below and details of their settings and options are in the following 
sections. 

·          Choose/Create Bathy Layer - options to create a new DTM file or append to an existing 
file. 

·          Select Input Lines - Choose which data files to process for the DTM. 

·          Ancillary Options - Vessel geometry settings and GSF/HTF options.  

·          Gridding of Soundings - Grid settings including resolution, encoding options, fill and 
smoothing options, and the option to constrain the DTM to the map extent. 

·           Raw Processing - Includes POS, navigation and TPE processing, and options for 
transducer selection and attitude correction thresholds. 

·          Beam Suppression - Several options for beam suppression with a separate tab for attitude 
suppressions.  

·          SVP Processing - Includes options for selecting and applying sound velocity profile data. 

·          Tide/Squat Processing - Includes options for selecting and applying tides and vessel 
squat. 
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5.2.3 Choose/Create Bathy Layer 

The first step of the BathyOne wizard is to create a new bathy layer or select an existing 
bathy layer to append to as shown in the image below: 

 

If a bathy layer already existed in the project, it will appear in the upper window under 
'Existing Layers'.  The user can either select the existing layer if present, or choose to create a 
new bathy layer by selecting the 'Create' button.   

 
Note that there are two types of bathy layers that can be created, a DTM or a TPE. 

·          DTM:  This stands for 'digital terrain model' and is the default bathy layer format used 
for gridding the depth values from the processing results. 

·          TPE:  This stands for 'total propagated error' and is used for a visual representation of the 
possible errors in the data results. 

 
Before moving to the next step of the BathyOne processing wizard, either an existing layer 
must be selected or a new layer created for the processing results.  If the user selects 'Create', 
to generate a new bathy layer, the following window will appear to name the layer and to 
select the output directory: 
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Note that the '.tmap_dtm' file extension will automatically be appended to the entered file 
name.   

When finished, select 'Save'.  This will create the new bathy layer and will automatically 
advance to the next processing step. 

 

5.2.4 Select Input Lines 

This page gives the user the option to select which lines to include in the bathy processing.  
All lines loaded in the project that contain bathymetry data will be included in this list as 
shown below: 
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The user can select individual lines by clicking on the check box to the right of the line name, 
or the user may choose 'Select All' or 'Deselect All'.  If a line is deselected, it will not be 
included in the DTM that is being created.  Using the 'Add Lines' tool, it is possible to append 
the DTM with the lines not included at a later time.   

 
When finished selecting the lines to include in the processing, click the 'Next' button to 
advance to the next processing step. 

 

5.2.5 Gridding of Soundings 

This page of the processing wizard as shown below gives the user the option to set output 
resolution, encoding options, fill and smoothing options, and the option to constrain the DTM 
to the map extent.   

 

 
Resolution: 

Enter the resolution of the DTM in meters per grid cell. 

Note that the resolution chosen should be something appropriate with regard to the water 
depth, number of beams, etc.  This is also the "bin" size into which the raw bathy soundings 
will be gridded.  The resolution sets the grid cell size and therefore the smaller the number, 
the larger the DTM file size of the final DTM file and the longer will be the processing time. 
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Encoding: 

Choose from the following options using the drop-down list: 

Last: The last value to fall in the bin being processed. 

Max: The deepest value to fall in the bin being processed. 

Min: The shallowest value to fall in the bin being processed. 

First: The first value to fall in the bin being processed. 

Average: The average of all the values that fall in the bin. 

 
Constrain to map view: 

Only process the data that falls inside the current map window.  This can be useful for quick 
previews of grid results or for generating small grid files that are quick to work with. 

 
Depth limit: 

Choose the correct range for the data.  If the data falls both deeper and shallower than 2000m 
choose > 2000m. 

 
Fill Filter: 

Turn this on to fill gaps between data points, the two settings allow either a Median or 
Inverse Distance filter to be used to compute the value of the depth being created. Also the 
size (number of bins) East-West and North-South that will be used.  

 
Smooth Filter: 

A low-pass filter that can be applied to the DTM.  The variables are similar to the Fill Filter.  
Use this filter with care, useful data can easily be removed! 

 
Hit 'Next' to continue to the Ancillary Options dialog. 

 
 

5.2.6 Ancillary Options 

This page of the processing wizard as shown below gives the user the option to indicate the 
vessel geometry, whether to include FTS (footprint time series) data in the GSF file, and 
whether to choose to generate an HTF file as well.   
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Vessel Geometry:  There are two options for vessel geometry.  Generally vessel geometry is 
stored in the raw data file header and can be read directly from the XTF file.  By default the 
'Use vessel geometry from XTF header' option is checked, and this information will be used 
for data processing.  Unchecking this option allows you to either 'Load' an existing geometry 
file or 'Create' to generate a different vessel geometry (.GEO) file. 

Selecting 'Load' will open a window for selecting an existing .geo_xml file. 

Selecting 'Create' will open a window to enter vessel geometry information and save a new 
.geo_xml file as shown on the next page: 
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Note that there is a drop-down list for 'Heave Ref.' with the following options depending on 
the source of the data and where in the XTF file the information is stored: 

 

When finished, select 'OK'.  This will open a window for entering the name of the vessel 
geometry file and selecting an output directory. 

 
GSF: Include FTS when available. 

All data is written internally to a standard GSF (Generic Sensor Format) file.  FTS (Footprint 
Time Series) data is beam imagery from within each beam footprint, sometimes called 
'Snippets'.  If the data contains this information then leaving the box checked will generate 
both a DTM and imagery from the FTS data in the GSF file. 
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This type of data requires a great deal of processing and the size of the XTF files can be very 
large. Unless there is a requirement for snippet imagery the box should be unchecked.  

 
HTF: Generate HTF 

Check this box and hit 'Settings' to save an HTF file.  Available settings are shown in the 
window below: 

 

Enter the requested information and select 'OK' when finished. 

 
Hit 'Next' to continue to the Raw Processing dialog. 

 

 

5.2.7 Raw Processing 

This page of the processing wizard as shown below includes POS, navigation and TPE 
processing, plus options for transducer selection and attitude correction thresholds.   



 

   

93 | P a g e   Februa ry 2011 
 

 

 
Precise Timing Architecture: 

Check this option if the data you are processing was acquired with a Reson Sonar and 
POS/RAW navigation attitude and heading data from an Applanix® POS/MV sensor.  This 
setting will take advantage of the precise timing link that exists between the Reson 
Multibeam Sonar and the POS sensor.  

 
Navigation Processing: 

This box is checked by default.  The standard setting will apply a boxcar filter using twelve 
navigation updates to create a running mean position.   

 
TPE Processing: 

If the TPE options was selected during the create bathy layer, then the settings for the TPE 
results are entered by selecting the 'Settings' button in the TPE Processing box..   

TPE processing options are shown in the image on the following page: 
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Algorithm Parameters:  Indicates what IHO survey order the data is intended to meet.  
Options include 'Special', 'One', 'Two', and 'Three'. 

Disambiguation:  Methods include 'Prior', 'Likelihood', and 'Posterior'.  The user can also set 
the maximum and minimum context to apply. 

Depth Range:  Expected depth range for collected data. 

Vertical Reduction:  Uncertainties with the vertical measurements are entered here for 'Draft', 
'Dynamic Draft', 'Loading', Tide Measured', and 'Tide Predicted'. 

Motion Sensor:  Uncertainties in the motion data are entered here for 'Pitch', 'Roll', 'Pitch 
Stabilization', 'Gyro', 'Heave', 'Heave Variability', and 'IMU Offset SDev' (standard 
deviation). 

GPS:  Uncertainties in the GPS data are entered here for 'Offset SDev', 'Latency SDev', and 
for 'DRMS'. 

Auxiliary Sensors:  Uncertainties in the sound velocity measurements are entered here for the 
'Cast SVP', 'Surface SVP', and for the 'Ground SVP' when applicable. 

Patch Test:  Uncertainties in the patch test results are entered here for the 'Roll/Pitch Align 
SDev', 'Heading Align SDev', and the 'Latency SDev'. 
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Select 'OK' when finished entering all parameters to return to the processing wizard. 

 
Transducer Selection: 

Users can select which head to process if multiple heads were used for data acquisition. 

 
UTC Timing Delay: 

Check this box if there is a known timing delay from using UTC timing.  Enter the delay in 
seconds. 

 
Attitude Correction Thresholds: 

Users can set the maximum amount of change between motion sensor updates. 

 
Hit 'Next' to continue to the Beam Suppression dialog. 

 

5.2.8 Beam Suppression 

There are two tabs for defining filters to suppress beam soundings.  The main tab is for 'Beam 
Suppression' and has several options for suppressing beams as shown in the image below: 

 

To enable beam suppression, the 'On' check box in the upper left corner needs to be checked.  
A brief description of each suppression filter is presented below: 
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Suppress Using Beam Quality:  The bathymetry data sent from the sonar will have some flags 
that have been set by the sonar; these are the Beam Quality flags Poor, Low, Bad.  Note the 
default settings reject only beams that are flagged as Bad by the sonar, but the user can 
choose to reject more data based on the Poor or Low sonar flags. 

Suppress Beams Outside Angle:  Suppress beams that fall outside an angle that the user may 
choose, allows potentially noisy outer beams to be rejected. 

Suppress Beams Using Depth Range:  Suppress beams that fall outside the expected depth 
range for the survey. 

Suppress Beams Using Gradient:  Suppress beams that exceed a predetermined value for 
gradient between adjacent beams. 

Suppress Beams Inside Angle:  Sonars that use the phase comparison method have very poor 
data directly below the transducer; this option allows that area to be suppressed. 

Suppress Beams Using Slant Range:  Suppress beams that exceed a predetermined value for 
slant range. For example the sonar range (slant range) may be set to 100m but all data beyond 
80m is noisy. 

Suppress using checksum:  Suppress beams that do not have the correct number of characters 
in the ping record.  Used mainly for serial data where data can be dropped or lost.  Use with 
care as some sonar manufacturers do not support this type of error checking and all your data 
may be flagged as bad. 

Suppress By Beam Number:  Must check the 'On' box to activate.  Can select individual 
beams with a mouse click.  Selected beams will turn red in the display as shown above and 
will be flagged as bad for processing.  If a beam was selected by mistake or if the user wishes 
to clear the selected beams in this window select the 'Reset' button to deselect all beams. 

 

 
 

The other tab available here is called 'Attitude Suppression'.  This is for suppressing beam 
soundings based on the range of motion between pings and has three options as shown in the 
image: 
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Each option must be individually enabled by checking the 'On' check box.   

Suppress Using Pitch Range:  This will suppress beam soundings if the pitch exceeds the 
range of values entered. 

Suppress Using Heave Range:  This will suppress beam soundings if the heave exceeds the 
range of values entered. 

Suppress Using Roll Range:  This will suppress beam soundings if the roll exceeds the range 
of values entered. 

 
Hit 'Next' to continue to the SVP Processing dialog. 

 
 
 

5.2.9 SVP Processing 
 

To enable the SVP Processing tab, the user must check the 'On' box in the upper left corner of 
the dialog as shown in the image below: 
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SVP Selection: 

The user has the option to select an individual SVP file, choose a folder with several SVP 
files or to manually enter a sound velocity value.   

SVP File:  Applies sound velocity profile from the selected cast. 

SVP Folder:  Applies the SVP file in the folder that is closest in distance to the vessel at the 
time of the ping. 

Single Beam (manual entry):  Enter a mean value, used for single beam data processing. 

Note that SVP files read by Perspective are .XML files created from the Raw ASCII data by 
the XML Utilities program.   

Files that are read successfully will generate a graph, you can click on a list of SVP files to 
compare the graphs, double-clicking the small graph window will display a large, resizable 
version. 
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If the cast has both Up and Down components then these are displayed as dark blue ‘Down’ 
and lighter blue ‘Up’. 

 
Sample from: 

There are choices to use either the 'Upcast', the 'Downcast' or the 'Merged' value from both. 

 
Velocity sampling: 

Choose whether to use the 'Mid-Sample' value or the actual 'Sample'. 

 
Refraction at transducer depth from: 

Off:  Use the value supplied by the sonar head sensor. 

CTD:  Use the value supplied by an external CTD sensor and logged in the XTF file as Sound 
Velocity. 

SVP:  Use the information read from the SVP graph for transducer depth. 

 
Hit 'Next' to continue to the Tide/Squat Processing Dialog. 
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5.2.10 Tide/Squat Processing 

To enable the Tide Data processing, the user must check the 'On' box in the upper left corner 
of the Tide Data options as shown in the image below: 

 

 
Tide Data: 

The user has the option to select an individual Tide File, choose a Tide Folder with several 
tide files or to Use RTK Tides.   

Tide File:  Applies predicted or collected tide data from a single file 

Tide Folder:  Applies predicted or collected tide data from multiple files in the selected folder 
using one of four interpolation methods shown in the drop-down list in the image above 
which are: 

·          Linear 

·          Spline 

·          Weighted Mean 

·          Planar Intersections 

Use RTK Tides:  Will read RTK tide data from raw data file if collected during acquisition. 
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Note that tide files read by Perspective are .XML files created from the Raw ASCII data by 
the XML Utilities program.   

Files that are read successfully will generate a graph; you can click on a list of tide files to 
compare the graphs.  Double-clicking the small graph window will display a large, resizable 
version: 

 

Note the survey time window is shown on the display as a vertical green band with the text 
"Covers Survey Time" indicating the tide files spans at least the duration of the survey data. 

 
Squat Table: 

If there is a vessel squat table available, check the 'Use' box and select the browse button to 
choose the file.   

Note that squat files read by Perspective are .XML files created from the Raw ASCII data by 
the XML Utilities program.   

 
Hit 'Finish' when done to generate the DTM and load it into Perspective Map. 

 

5.3 Rebuild Using  

This feature allows the user to change some of the grid processing parameters set in the bathy 
processing wizard.  To start the rebuild process, right-click on the DTM layer in the 
Bathymetry file tree node and select 'Rebuild using' as shown in the image: 
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Selecting this will launch the BatyhOne Wizard. 

 
After selecting the 'Rebuild using' option, a window will pop-up and ask if you want to re-
apply the flags already in the GSF from the parameters set when the DTM was created as 
shown below: 

 

Select 'Yes' if you want to do further processing of the DTM, or 'No' to ignore the existing 
flags in the GSF and restart the processing from scratch.  Both options start the BathyOne 
Wizard, the difference is in the options available on the beam suppression page.  If the user 
selected 'No' in the GSF Flags window above, then the Beam Suppression page of the 
BathyOne Wizard will look the same as during the create DTM process.  However, selecting 
'Yes' above will limit the user’s ability to change the beam suppression options as shown in 
the image below: 
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5.4 Edit GSF Using 

This feature allows the user to change some of the grid processing parameters set in the bathy 
processing wizard during GSF File import.  To start the GSF editing process, right-click on 
the DTM layer in the Bathymetry file tree node and select 'Edit GSF using' as shown in the 
image below: 

 

 
After selecting the 'Edit GSF using' option, a limiter version the BathyOne Wizard will 
launch to allow for changes to the parameters set during the import/gridding process.  
Presented below are the only BathyOne Wizard pages available with the 'Edit GSF Using' 
option.  Note that there is an additional page not in the normal BathyOne Wizard at the end 
for entering comments. 
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5.5 Re-Merge DTM 

Selecting this option will apply any changes made to the processing parameters or edits to the 
data made since the DTM was created.  This feature is only available by right-clicking on the 
DTM in the bathy layer node as shown below: 

 

This process happens automatically with no user set options available. 

 

5.6 Add Lines 

During the Create DTM process, it is possible to exclude some lines from being included in 
the DTM.   

To add lines to an existing DTM, right-click on the DTM in the Bathymetry file tree layer 
and select 'Add Lines' as shown: 
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Selecting this will open the following window containing a list of all the files added to the 
project but not included in the DTM as shown below: 

 

Choose which lines to include by checking the box to the left of each line (they are all 
checked by default), or by using the 'Select All' or 'Deselect All' buttons.  Click on 'Finish' 
when ready to add the chosen lines to the DTM. 

 

5.7 Reset Date 

When a DTM is created it automatically reads the acquisition data from the raw data file and 
appends that to the file name in Perspective Map as shown below: 
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If a user wished to instead have a different data assigned to the DTM such as the processing 
date, there is a tool to accomplish this.   

 
Right-click on the DTM and select 'Reset Data' as shown below: 

 

The following window will pop up: 

 

Enter the desired date and select 'OK' when done. 

This will revise the file tree display of the DTM to reflect the new date as shown below: 

 

 

5.8 Rename 

The file tree display name for a DTM contains the date in parentheses followed by the file 
name chosen when it was created as shown in the image below: 

 

If a user would like to change the file tree display name for a DTM, there is a tool to 
accomplish this.   
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Right-click on the DTM and select 'Rename' as shown below: 

 

The following window will pop up: 

 

Enter the desired name and select 'OK' when done. 

This will revise the file tree display of the DTM to reflect the new date as shown below: 

 

 

5.9 Visualization Options 

5.9.1 Color Settings  
 

The imagery color settings for bathymetry layers can be changed for individual DTMs on a 
layer by layer basis or globally for all DTMs depending on which tree node the color settings 
are selected from.   

Right-click on the DTM layer or root bathymetry file tree node and select the 'Color Settings' 
option as shown below: 
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Selecting 'Color Settings' will open the following window: 

 

Options available in the Color Settings window are: 

·          Transparent Color:  Checking this box will make the imagery transparent 

·          Opacity:  Allows the user to change the opacity of the image, from 0 to 1.0, with 1.0 
being full opaqueness 

·          Gamma:  The gamma of an image is a measure of its contrast and brightness. By 
correcting the gamma, you can adjust these two elements in unison. 

·          Brightness:  The user can change the brightness of the image.  A positive number will 
correspond to a brighter image, and a negative number will correspond to a darker image. 

·          Contrast:  Allows the user to change the contrast of the image.  The contrast of an image 
is the difference in brightness between due adjacent pixels. 

·          Invert:  Checking the box next to invert will invert the color scheme that is applied. 

The button next to the color bar opens the Gradient Manager shown below.   
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In this dialog the user can change the Lutz table applied and the algorithm used in the 
application of the color spectrum.  The user may also invert the application of the color tables 
by checking the box next to Invert within this dialog or within the main “Group Color 
Settings” dialog. 

5.9.2 Bathy Histogram 

The histogram window is a graphical representation of the imagery signal level in dB versus 
the occurrence of that dB within the image.   

To open the histogram window, right-click on the DTM layer or root bathymetry file tree 
node and select the 'Histogram' option as shown below: 

 

 
Selecting 'Histogram' will open the following window: 
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This window shows two overlapping histograms, one is the original histogram and the other 
represents the modified histogram based on the adjustments the user makes here.  Options in 
the histogram window include: 

Window Options:  The two square boxes along the bottom of the window act as nodes for 
manually adjusting the portion of the spectrum to be displayed.  The lower and upper dB 
bounds can be set by left-clicking on the node and dragging it while the mouse button is 
depressed.  When the mouse button is released the color map of the DTM layer in the map 
view will automatically update. 

Color Legend:  The gray histogram is the spread of the actual data.  The green is the 'contrast-
stretched' histogram of the data as defined by the user selected min/max range of the data.  
The green histogram will be the actual data within the user-defined limits spread out over the 
entire graph range (dB).   

Auto-Contrast:  During the construction of the DTM the program uses the default settings to 
improve the initial appearance of the image, program defaults are Bias 0% and Threshold 
1%.  The threshold setting determines where the upper and lower limits of the histogram are 
located, based on the threshold curve.  A higher Threshold setting will move the upper and 
lower limits closer together.  The Bias setting again moves the upper and lower limits closer 
together but allows the user to ignore the histogram curve.  The defaults of 0% and 1% 
therefore should include almost all values in the image with very little clipping.  Selecting 
‘Compute’ will apply the changes made to the Bias and Threshold to the Histogram. 

Reset:  Allows the user to return the histogram to the original spread that was set during 
creation of the image. 

 

 
An example of how the histogram options affect the DTM display is shown here.   

When the user first opens the Bathymetry Histogram window, the histogram displayed was 
designed to span the full range of signals in the DTM.  This however can lead to a color 
imbalance where much of the DTM appears the same color.  Shown on the following page is 
an example of this, showing the default histogram for a DTM and the resulting color 
distribution. 
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Adjusting the portion of the spectrum to display can enhance the vertical changes in the DTM 
as shown on the following page: 
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Additional adjustments can be made in the Auto Contrast section to enhance the color 
distribution.  Applying a Bias of 2.4% and a Threshold of 7.4% to the histogram results 
shown above yields the following color distribution: 

 

 

 

 

This is a bit extreme but shows how the Bias and Threshold settings can affect the histogram 
and resulting color distribution. 

 

5.9.3 Relief Shading 

Relief Shading simulates the illumination of the sun on the bathymetry data.  This is a global 
setting and can only be changed at this node level. 
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Right-click on the DTM layer or root bathymetry file tree node and select the 'Relief Shading' 
option as shown below: 

 
 

Selecting 'Relief Shading' will open the following window: 

 

By checking the box next to “On” the user can create relief shading of the bathymetry image.  
The color square next to “On” allows the user to select a “beam” shade.  This will be the 
overall translucent color cast on the image.  Other user-defined settings include: 

·          Sun Elevation:  This is the elevation of the beam in degrees above the theoretical 
horizon.  For example, 30 degrees would show relief as viewed from 30 degree above the 
horizon.   

·          Sun Azimuth:  This is position of the beam source.  For example, 270 degrees would 
display the image, as a beam shined on it directly from the West. 

·          Reflectivity:  This adjusts the amount of energy that would be reflected from the applied 
sun illumination affecting the brightness of the image. 

·          Scaling:  This applies a multiple factor to exaggerate or diminish the gridded data relative 
to itself.  It works as a vertical exaggeration to emphasize topographic relief in the shaded 
imagery. 

 
Here is an example of bathymetry data without relief shading and then with relief shading 
turned on: 
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Selecting the color patch next to the 'On' checkbox will open the 'Color' window to select a 
color to use to shade the beam illumination as shown below: 

 

By selecting a color here and clicking 'OK', the chosen color will 
appear in the 'Relief Shading' window as shown below: 

 

 

 

 

 

This will 
change the beam 
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illumination from white and will have the following results: 

 

 

 

5.9.4 Swath Viewer 

The 'Swath Viewer' allows the user to see the swath of individual data lines.  This tool can be 
launched by right-clicking on either the individual line in either the Navigation file tree layer 
of from the Imagery/Bathymetry file tree layer.  Both of these options to launch the Swath 
Viewer are shown below, respectively: 
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Selecting either option will open the following window: 

 

Notice that the beams flagged as bad are marked red in the viewer.  The slider bars to the left 
and below the swath data are for setting the scale of the window.  Selecting the 'Processing' 
button will open the BathyOne Wizard for viewing the processing steps made. 

The bottom slider bar is for indicating the progress through the data file.  This position is tied 
to the map view and is represented by a red circle called the "pipper" which moves along the 
navigation line as the swath viewer progresses through the file to correlate features seen in 
the map view to the raw swath data.  An example of the "pipper" location is shown in the 
image below: 
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Here the pipper is located at the start of the navigation line for line BRDG026.xtf. 

5.10 Interpretation Options 

5.10.1 Bathy Profile 

Profiles can be generated once a DTM layer is created or loaded into the project.  The profile 

tool is launched from the toolbar button    or by selecting 'Bathy Profile' from the 
Modality menu. 

Selecting 'Bathy Profile' or the toolbar button will change the cursor mode so that it can be 
used to select a line in the map view, to see a profile of the data that line intersects.   

To draw a profile line in the map view, left-click at the desired start point and hold the mouse 
button down while the cursor is dragged to the desired end point.  The line drawn will appear 
in the map view as shown in the image below: 

 

 

Note that the line drawn also doubles as a measurement tool 
and the length of the drawn line is displayed automatically 
in the Measure Tab, as shown below: 
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When the mouse button is released the Bathy Profile window opens and displays an along-
line profile of all of the DTM layers existing beneath the profile line.   

 

The image above shows three profile lines, corresponding to the three DTM layers in the 
project.  The user has the option to uncheck the box next to the listed bathy layers in order to 
turn an individual profile line off from the display. 

The window comes with a display of the cursor position and depth, and the option to view 
continuous lines or discreet points only.  The cursor display can be customized to show the 
location in any coordinate system supported by Perspective Map by clicking on the button to 
the right of the position information and selecting the desired projection and datum.  This 
button functions the same as the Custom Cursor options. 

 
Another feature of the Bathy Profile tool is the connection between the cursor position in the 
profile view and the cursor position in the map view.  Shown in the following image is this 
relationship between profile and map cursor positions which is useful for identifying the 
locations in the map view of features seen in the profile: 
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5.10.2 Bathy A-B 

The difference between two layers can be calculated with the 'A-B' tool and output as a 
separate DTM.  This tool can be used to determine the differences between DTM layers by 
selecting the entire layer or just a user-defined portion of the layer. 

 
To calculate the differences between entire DTM layers using 'A-B', right-click on the DTM 
you wish to subtract from and select 'A-B' from the menu options as shown below: 

 

Selecting this menu option will open the A-B window discussed below. 
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To determine the difference between layers in a user-defined area, the user needs to first 

switch to 'A-B' mode by either selecting the 'A-B' toolbar button    in Perspective Map or 
the 'A-B' option in the 'Modality' menu.  

Once in 'A-B' mode, select a starting point on the map by left clicking on the spot and holding 
the button down while the area to be used for the A-B calculation is defined.  A box will be 
drawn in the screen defining the area and when done, release the mouse button to open the A-
B window. 

 
The A-B window shown below will launch regardless of whether you are differencing over a 
small area or the entire DTM layer. 

 

The window on the left lists available DTM layers in the project to use for the calculation.  
Note that the layer selected will be subtracted from the layer right-clicked on in the file tree 
or from the top layer if selecting an area on the map. 

Options available in the A-B window include: 

Min Delta:  This sets the minimum value for the layer difference to include in the output 
DTM.  This is useful for removing background noise from the difference layer. 

Max Delta:  This sets the maximum value for the layer difference to include in the output 
DTM.  This is useful for targeting objects of a particular size from the difference layer. 

Absolute/Positive/Negative:  Gives the user the option to include the 'Absolute' values of all 
differences in the output DTM layer, or just the 'Positive' values or just the 'Negative' 
difference values. 

A-B Depth Delta:  Allows the user to adjust for known depth difference.  Useful for 
comparing shapes of features when there is static depth shift between the data layers due to 
tides or sound velocity errors. 

Selecting 'OK' will launch the Save File dialog to choose a name for the DTM difference 
layer and for selecting the file directory. 
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The difference DTM created from this process will automatically load into the project and 
can be found in the Imagery/Bathymetry file tree layer. 

 
Shown below is an example of the area selected for A-B calculation.  The top image shows 
they are selected and the selection bounding box is in light blue.  The lower image shows the 
difference between the top layer which is visible and the layer beneath collected on a 
previous day: 

 

 

Shown in the image above in red are the only differences identified between 0.3 and 3.0 
meters in the area selected as defined by the dashed blue line in the upper image.  Please note 
that this requires good co-registration between layers and very good motion compensation to 
limit noise artifacts from appearing in the difference calculation. 
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5.10.3 Bathy Change Detection 

The difference between two layers can be calculated with the 'Change Detection' tool and 
output as a separate DTM.  This tool can be used to determine the differences between entire 
DTM layers and uses the same as dialog as the A-B tool.  This algorithm differs slightly from 
the A-B algorithm in that it also includes a statistical neighborhood approach to account for 
mis-registration between layers.   

 
To calculate the differences between entire DTM layers using 'Change Detection', right-click 
on the DTM you wish to subtract from and select 'Change Detection' from the menu options 
as shown below: 

 

Selecting the 'Change Detection' menu option will open the same A-B window discussed in 
the previous section. 

The difference DTM created from this process will automatically load into the project and 
can be found in the Imagery/Bathymetry file tree layer. 

 

5.10.4 Bathy Blink Comparator 

To quickly compare two overlapping DTM layers, the 'Blink Comparator' tool can be used.  
The 'Blink Comparator' allows the user to quickly turn on/off a layer or can be set to cycle a 
layer on/off to help identify differences in the layers.   

To use the 'Blink Comparator' tool, right-click on the DTM you wish to "Blink" (cycle on and 
off) and select 'Blink Comparator' from the menu options as shown below: 

 

Selecting the 'Blink Comparator' menu option, the following window will open: 
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The options available in the 'Blink Comparator' include: 

Layer On:  This will turn the selected layer on in the file tree so the layer is displayed in the 
map view. 

Layer Off:  This will turn the selected layer off in the file tree so the layer is not displayed in 
the map view. 

Cycle:  This will turn cycle the layer on and off in the map view at the user set frequency 
using the slider bar to the right of the Cycle option. 

 
An example of the use of this tool is presented below.  The top image is with the selected 
layer off so the user can see the layer underneath.  The next image shows the selected layer 
cycled on showing an object on the bottom surface that was not present in the previously 
collected data. 
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5.10.5 Bathy Statistics 

The statistics that can be calculated from a DTM layer include the following: 

·          Allocated Coverage:  This is the number of square nautical miles which the tiles used to 
store the data in the DTM layer represent.   

·          Actual Coverage:  This is the number of square meters of the actual ensonified area.   

·          Total Lines:  This is the number of lines included and used in the creation of the DTM 
layer. 

·          Along-Track Distance:  This is the combined along-track distance of all lines included 
and used in the creation of the DTM layer. 

·          Depth Range:  This is the range of depth values in the selected DTM layer. 

 
To use the 'Statistics' tool, right-click on the DTM you wish to extract the statistics from and 
select 'Statistics' from the menu options as shown below: 

 

 
Selecting the 'Statistics' menu option will calculate the statistics discussed above and display 
them as shown in the following window: 
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6: MosaicOne 
 

6.1 MosaicOne Module 

MosaicOne is an add-on to Perspective Map which allows users to create digital mosaics of 
their raw sidescan data and includes tools for viewing and interpolating the processed data.  
Options available in the MosaicOne module are presented below and details of their options 
and settings are in the following sections. 

 
Mosaic Options 

Create Mosaic:  MosaicOne provides a few methods for the creation of sidescan mosaics.   

Re-merge Mosaic:  Will re-create the mosaic based on any changes to the processing 
parameters made since the mosaic was created.   

Add Lines:  Allows the user to add other raw data files in the project to the mosaic.   

Force Regeneration:  Forces the rebuild of the mosaic file used after making changes to 
individual lines.   

Move Line:  Allows the user to move a line in the mosaic to correct for misalignments due to 
towfish position errors.  When finished, this process automatically rebuilds the mosaic file 
using the new line location.   

Remove (line):  Allows the user to remove a line from a mosaic in the project.   

 
Waterfall Viewer Options and Tools 

Waterfall Viewer:  This tool allows the user to see the waterfall data from an individual 
sidescan data file.  Details of the Waterfall Viewer are discussed in Section 6.9. 

Playback Contols:  Used to control the playback of the raw sidescan data in the waterfall 
viewer.  Details of the Playback Control options are discussed in Section 6.9.6. 

Bottom Tracking:  Necessary to properly remove the water column data from the results.  
Details of the Bottom Tracking options are discussed in Section 6.10.1. 

Slant Range Corrections:  Corrects for altitude of the sonar using the bottom tracking results.  
Details of the Slant Range Correction options are discussed in Section 6.10.2. 

Speed Corrections:  Necessary to adjust waterfall playback for variations in survey speed.  
Details of the Speed Correction options are discussed in Section 6.10.3. 
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Waterfall TVG:  Applies a user defined TVG function to the waterfall display.  Details of the 
TVG options are discussed in Section 6.10.6. 

 
Visualization Options 

Color Settings:  Allows the user to change the color characteristics of the sidescan layer.   

Histogram:  This is the graphical representation of the imagery signal level in dB versus the 
occurrence of that dB within the image.   

 
Interpretation Options 

Blink Comparator:  Visual comparison of two overlapping layers is made easy with this tool.  
The 'Blink Comparator' allows the user to quickly turn on/off a layer or can be set to cycle a 
layer on/off to help identify differences in the layers.  The options available in the 'Blink 
Comparator' are described in detail at Section 6.11.1. 

Statistics:  This gives an overview of the data used to create the image including coverage 
and line statistics.  Details of the statistics tool and the results displayed are presented in 
Section 6.11.2. 

Targeting (TargetOne): An extensive targeting module for extracting targets from waterfall 
data and mosaics.  Options available with TargetOne are presented in Section 6.11.3 

Classify (SeaClass):  Extensive classification module for determining bottom types from 
sidescan mosaic files and from GeoTiffs.  Options available with SeaClass are presented in 
Section 8.3. 
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6.2 Create Mosaic 

6.2.1 Sidescan Processing Wizard 

Sidescan data can be processed in Perspective Map using the MosaicOne Wizard.  Presented 
below are a few ways to launch the sidescan processing wizard.   

During the raw data import process, the navigation data loads into the project first.  If the raw 
data files contain sidescan data then the MosaicOne Wizard will automatically launch and the 
sidescan data can be processed as part of the import process. 

However there are a few cases where the mosaic wizard should be canceled during the import 
process and re-launched after the navigation data is properly processed.  Reasons for skipping 
the mosaic process upon import include: 

��       The navigation data needs repeat processing.  

��       The bottom tracking is not saved in the raw XTF data, so the mosaic will not be slant-
range corrected.   

 
There are two methods to launch the MosaicOne Wizard manually from within Perspective 
Map; from the File Tree or using the toolbar button. 

��       To launch the wizard from the File Tree, right-click on the Imagery/Sidescan node and 
selecting 'Create' as shown below: 

 

��       The processing wizard can also be launched by selecting the 'Create Mosaic' toolbar 
button:    

           

 
Whether the processing wizard is automatically launched or manually as described above, the 
same options are available.  Processing steps in the MosaicOne Wizard are presented in the 
following section.  
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6.2.2 MosaicOne Wizard Overview 

There are several steps the MosaicOne Wizard guides the user through. Brief descriptions of 
each step are presented below and details of their settings and options are in the following 
sections. 

·          Choose/Create Mosaic Layer - Options to create a new mosaic file or append to an 
existing file. 

·          Choose Mosaic Settings - Includes resolution, line merging options, and transducer 
offsets. 

·          Select/Order Input Lines - Choose which data files to process for the mosaic. 

·          Choose Line Settings - Includes channel options, swath clipping, and navigation 
processing. 

6.2.3 Choose/Create Mosaic Layer 

The first step of the MosaicOne wizard is to create a new mosaic layer or select an existing 
mosaic layer to append to as shown in the image below: 

 

If a mosaic layer already existed in the project, it will appear in the upper window under 
'Existing Layers'.  The user can either select the existing layer if present, or choose to create a 
new mosaic layer by selecting the 'Create' button.   

 
Before moving to the next step of the MosaicOne processing wizard, either an existing layer 
must be selected or a new layer created for the processing results.  If selecting 'Create' to 
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generate a new mosaic layer, the following window will appear to name the layer and to 
select the output directory: 

 

Note that the '.tmap_moz' file extension will automatically be appended to the entered file 
name.   

When finished, select 'Save'.  This will create the new mosaic layer in the selected directory 
and will automatically advance to the next processing step. 

 

6.2.4 Choose Mosaic Settings 

This page of the processing wizard as shown below gives the user the option to set output 
resolution, choose overlapping line options, constrain mosaic to map view, enable single 
channel auto-flip, and set transducer offsets.  Also on the page is the option to save the 
mosaic settings selected or to load from an existing saved settings file. 
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General Settings: 

Resolution:  Enter the resolution of the mosaic in meters per pixel. Use any of the predefined 
values or enter a custom value. 

Combine Overlapping Lines Using:  There are four options as shown in the image below: 

 

·          Maximum - Will cause stronger returns to "shine-through" an overlapping line. (default). 

·          Minimum - Will cause weaker returns to be preserved when lines overlap. 

·          Over - Lines will be displayed based only on the order in which they were mosaiced. 

·          No Step - No merging will take place, existing imagery will be preserved, new lines will 
not overwrite. 

Constrain to map view:  Only generates the mosaic in the visible map view window. 

Automatic Gain Control:  Applies an automatic gain to each line to account for signal 
attenuation in analog data. 

 
Single Channel Auto Flip: 

Where a mosaic has sufficient raw data overlap it may be possible to mosaic only one 
channel on lines running in opposite directions.  Perspective detects the line direction and 
selects the correct channel.  The resulting mosaic will have shadows only on one side of all 
objects, which can give superior results by removing the "double shadow" problem.   

The user needs to select the 'On' box to enable this option, and can select the starting line and 
also the starting channel. 

 
Transducer Offsets (hull mounted): 

When the sidescan sonar is hull mounted, instead of using layback, transducer offsets need to 
be entered to account for the difference in position between the GPS receivers and the sonar 
transducer.   

The user needs to select the 'On' box to enable this option, and can select the across track and 
along track offsets. 

 
Load/Save Options: 

There are two additional buttons available on the page of the MosaicOne Wizard, 'Load' and 
'Save'. 
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Load:  This will load an existing saved mosaic settings file.  Clicking this button opens a file 
browser to locate and select a previously saved settings file. 

Save:  This will save the entered settings on this page of the MosaicOne wizard to an XML 
file for quick loading for processing subsequent mosaics.  

 
Hit 'Next' to continue to the next page of the processing wizard. 

 
 
 

6.2.5 Select/Order Input Lines 

This page gives the user the option to select which lines to include in the mosaic processing 
and also what order to use for overlapping.  All lines loaded in the project that contain 
sidescan data will be included in this list as shown below: 

 

Options include selecting individual lines by clicking on the check box to the right of the line 
name, or the user may either 'Select All' or 'Deselect All'.  If a line is deselected, it will not be 
included in the mosaic that is being created.  Using the 'Add Lines' tool, it is possible to 
append the mosaic with the lines not included at a later time.   

In addition to selecting which lines will be included in the mosaic, the user can also select 
what order they are loaded in for processing line overlaps. 

 



 

   

133 | P a g e   Februa ry 2011 
 

When finished selecting and ordering the sidescan lines for processing, click the 'Next' button 
to advance to the next processing step. 

 

 

6.2.6 Choose Line Settings 

This page of the processing wizard as shown below gives the user the option to set channel 
down-sampling and overlap options, process navigation, enable interpolation to fill between 
pings, set the heading source, and to clip the inner and outer swath by percent.  Also on the 
page is the option to apply these settings just to a specified line or to all lines. 

 

 
Channel 

Both the 'Downsampling' and 'Combine Overlap' options refer to the method by which 
overlapping data from within one line is handled. 

Downsampling:  Refers to the across track element (sample to sample within a ping). 

Combine Overlapping:  Refers to the merging of samples when a line overlaps itself.  

Each has the following options:  

·          Average - The average pixel value is calculated and used. 
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·          Maximum - The pixel with the highest value (maximum) is used. 

·          Minimum - The pixel with the lowest value (minimum) is used. 

·          RMS - Root Mean Square is a statistical measure of the magnitude of pixel values. It is 
the square root of the mean of the squares of the pixel values. 

·          Skip - Does not apply this step, overlap is handled by input line order. 

 
Navigation 

This box is checked by default.  The standard setting will apply a boxcar filter using twelve 
navigation updates to create a running mean position.   

 
Fill Between Pings 

·          None - Do not fill. 

·          Interpretation - Calculates a smooth transition from the pixels in one swath to the next. 
(default). 

 
Source of Heading 

This will tell Perspective what to use as the source for the heading when creating the mosaic.  

·          Sensor – Use the heading sensor which is integrated into the towfish as the source. 

·          Ship - Use the heading that is recorded for the ship as the source. 

·          Line Median - The mean line heading, useful when the survey lines are straight. 

 
Port Channel / Starboard Channel 

Select which channels of data to use in the mosaic.  Typically in a dual frequency system Ch 
3 and Ch 4 will be a higher frequency with better resolution but shorter range than Ch 1 and 
Ch 2. 

 
Inner/Outer Boundary Clipping 

Allows parts of the swath to be blanked out, for example the outer ends of a sidescan swath 
may be noisy and contain no data, likewise the area directly beneath the towfish is often not 
used. 

 
Apply To 

The parameters set in 'Choose Mosaic Settings' and 'Choose Line Settings' will be applied to 
either 'All' lines or only to a user specified line. 

 
Click 'Finish' to generate the mosaic: 
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6.3 Re-Merge Mosaic 

Selecting this option will apply any changes made to the processing parameters since the 
mosaic was created.  This feature is only available by right-clicking on the mosaic in the 
sidescan layer node as shown below: 

 

This process happens automatically and there are no user set options available. 

6.4 Add Lines 

During the Create Mosaic process, it is possible to exclude some lines from being included in 
the mosaic.  This is done in the 'Select/Order Input Lines' page of the MosaicOne Wizard.   

To add lines to an existing mosaic, right-click on the mosaic in the Sidescan file tree layer 
and select 'Add Lines' as shown below: 

 

Selecting this will open the following window containing a list of all the files added to the 
project but not included in the mosaic as shown below: 
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Choose which lines to include by checking the box to the left of each line (they are all 
checked by default), or by using the 'Select All' or 'Deselect All' buttons.  Click on 'Finish' 
when ready to add the chosen lines to the mosaic. 

This will bring up the last page of the MosaicOne Wizard as shown below for adjusting the 
line settings. 

 

Select 'Finish' when done. 

 

6.5 Force Regeneration 

This option is only available at the sidescan data line file tree level as shown below: 

 

Selecting this option will apply any changes made to the line settings since the mosaic was 
created.  This process happens automatically and there are no user set options available. 
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6.6 Move Line 
 

To accommodate for layback errors in data from towed sidescan sonars, Perspective has a 
tool which allows the user to move a sidescan line to align features to known locations or to 
features on adjacent lines.   

This tool is launched by right-clicking on an individual data file within a sidescan mosaic as 
shown below: 

 

Selecting the Move Line option will open a separate window which shows the mosaiced lines 
with the selected line not fixed and available for moving around the screen.  The image below 
is an example of the Move Line Tool window showing four lines of data: 

 

The selected sidescan line can easily be moved around the screen by simply clicking 
anywhere in the window and moving the cursor around while holding the click button down.  
The following image shows the results of a line move: 
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This image shows the line relocated to the northeast by 245.24 meters.  The display also 
shows the horizontal (X) displacement and the vertical (Y) displacement.  The line Opacity 
can also be adjusted to see through the selected line, in order to better align the line to 
features in the adjacent sidescan lines.   

Toolbar buttons are available to zoom-in and zoom-out of the window view. 

Select 'OK' when finished with moving the line.  This will force the regeneration of the 
mosaic incorporating the new line position into the mosaic. 

 

6.7 Remove Line 

This option is only available at the sidescan data line file tree level as shown below and 
allows the user to remove a line from inclusion in the sidescan mosaic layer. 

 

Selecting this option will only remove the line from the mosaic and not remove the line from 
the project.  The following dialog box will appear after selecting this option asking if the user 
is sure about doing this. 
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Selecting Yes' will re-merge the mosaic without the selected line included. 

 

6.8 Visualization Options 

6.8.1 Color Settings 

The imagery color settings can be changed for individual mosaics by right-clicking on an 
individual mosaic layer and selecting 'Color Settings' as shown below: 

 

This will open the following window: 

 

Options available in the Color Settings window are: 
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·          Transparent Color:  Checking this box will make the imagery transparent 

·          Opacity:  Allows the user to change the opacity of the image, from 0 to 1.0, with 1.0 
being full opaqueness 

·          Gamma:  The gamma of an image is a measure of its contrast and brightness. By 
correcting the gamma, you can adjust these two elements in unison. 

·          Brightness:  Allows the user to change the brightness of the image.  A positive number 
will correspond to a brighter image, and a negative number will correspond to a darker 
image. 

·          Contrast:  Allows the user to change the contrast of the image.  The contrast of an image 
is the difference in brightness between due adjacent pixels. 

·          Invert:  Checking the box next to invert, will invert the color scheme that is applied. 

The button next to the color bar opens the Gradient Manager shown below.   

 

In this dialog the user can change the Lutz table applied and the algorithm used in the 
application of the color spectrum.  The user may also invert the application of the color tables 
by checking the box next to Invert within this dialog. 

 

6.8.2 Mosaic Histogram  

The histogram window is a graphical representation of the imagery signal level in dB versus 
the occurrence of that dB within the image.   

To open the histogram window, right-click on the mosaic layer in the sidescan file tree node 
and select the 'Histogram' option as shown below: 
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This window shows two overlapping histograms, one is the original histogram and the other 
represents the modified histogram based on the adjustments the user makes here.  Options in 
the histogram window include: 

Window Options:  The two square boxes along the bottom of the window act as nodes for 
manually adjusting the portion of the spectrum to be displayed.  The lower and upper dB 
bounds can be set by left-clicking on the node and dragging it while the mouse button is 
depressed.  When the mouse button is released the color map of the mosaic layer in the map 
view will automatically update. 

Color Legend:  The gray histogram is the spread of the actual data.  The green is the 'contrast-
stretched' histogram of the data as defined by the user selected min/max range of the data.  
The green histogram will be the actual data within the user-defined limits spread out over the 
entire graph range (dB).   

Auto-Contrast:  During the construction of the mosaic, the program uses the default settings 
to improve the initial appearance of the image; program defaults are Bias 0% and Threshold 
1%.  The threshold setting determines where the upper and lower limits of the histogram are 
located, based on the threshold curve.  A higher Threshold setting will move the upper and 
lower limits closer together.  The Bias setting again moves the upper and lower limits closer 
together but allows the user to ignore the histogram curve.  The defaults of 0% and 1% 
therefore should include almost all values in the image with very little clipping.  Selecting 
Compute will apply the changes made to the Bias and Threshold to the Histogram. 

Reset:  Allows the user to return the histogram to the original spread that was set during 
creation of the image. 
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6.9 Waterfall Viewer 

6.9.1 Waterfall Module 

The waterfall module is part of MosaicOne and allows users to view the raw sidescan data in 
a waterfall viewer, collect targets from the raw data, and apply bottom tracking and slant 
range corrections.  Options available in the waterfall viewer are presented below. 

 
Launch Waterfall Viewer 

There are three ways to launch the waterfall viewer from Perspective.   

��       Right-click on the line in the navigation file tree as shown below: 

 

��       Right-click on the line in the imagery file tree as shown below: 

 

��       Double-click on the sidescan navigation line in the Map View as shown below: 
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Waterfall Options 

The waterfall layout is described in Section 6.9.2. 

Menu and Toolbar options are presented in Sections 6.9.3 and 6.9.4. 

Information displays are discussed in Section 6.9.5 

File playback options are presented in Section 6.9.6. 

The link between the map view and the waterfall viewer is discussed in Section 6.9.7. 

 
Waterfall Tools 

Bottom tracking is described in Section 6.10.1. 

Slant range corrections are discussed in Section 6.10.2. 

Speed corrections are discussed in Section 6.10.3. 

Histogram options are presented in Section 6.10.4. 

LUT options are presented in Section 6.10.5. 

TVG options are presented in Section 6.10.6. 

Target collection from the waterfall window is discussed in Section 6.10.7. 
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6.9.2 Waterfall Layout 

 
Waterfall Window Layout 

  Image View  

Displays the raw sidescan data as a waterfall. 
 

 Status Windows 

Information regarding navigation, ship and sensor data and cursor position are 
displayed here. 
 

 Playback Controls  

Includes a slider bar for monitoring and controlling position in the data file, 
standard controls for playing back and pausing sidescan data in the waterfall 
view, and end of file options.  
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6.9.3 Waterfall Menu Options 

File Menu 

 

At End of File: 

Options for how to proceed with the file playback once the end of the file is reached.  The 
image below shows the available settings: 

 

Go Back to Start - Restarts the playback from the beginning 

Go to Next File in Time - Starts playback of the next file in time that is in the project 

Stop - Stops playback and pauses at the end of the file 

Go To: 

Options for how to proceed with the file playback once the end of the file is reached.  The 
image below shows the available settings: 

 

Start - Moves waterfall view to start of file. 

End - Moves waterfall view to end of file. 

Ping - Moves waterfall view to a ping number entered as shown below. 
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Time - Moves waterfall view to a selected time as shown below, the window indicates time 
range to select within. 

 

Next File in Time - Starts playback of the next file in time that is in the project. 

Previous File in Time - Starts the playback of the previous file in time with the project. 

Scroll Forward:  Starts the waterfall scrolling forward. 

Scroll Back:  Starts the waterfall scrolling backward. 

Bottom Tracking:  Opens 'Bottom Tracking' tool.   

 
Contact Menu 

 

Clear All Bookmarks:  Removes all the target bookmarks from the XTF file. 

Settings:  Opens the contact (target) settings window 

Bookmarks and contact settings are discussed in detail in the TargetOne Section at 7.1. 
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6.9.4 Waterfall Toolbars 

Main Toolbar 
 

 
 

 Single sidescan waterfall window 
 Double sidescan waterfall windows 

 Separate parameter window 

 Previous – moves backwards in waterfall window one screen at a time 

 Forward – moves forwards in waterfall window one screen at a time 

 Refresh Window 
 Turn On/Off Slant Range 
 Turn On/Off Speed Correction 
 Open LUT Settings 

 Histogram Settings 

 Launch Bottom Tracking Tool 
 TVG Settings 

 
Contact Toolbar 
 

 
 

 Launch TargetOne module 

 Clear Bookmarks 
 Open Contact Settings 

 
 

6.9.5 Waterfall Information Displays 
The sidescan waterfall viewer has four information displays below the waterfall data display 
window.  The 'Navigation', 'Ship', and 'Sensor Data' information is read from the XTF and 
updates as the file is played back.  The information comes from the center of the display (top 
to bottom) where the blue dashed line crosses the screen as shown here: 
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The 'Cursor' information shows the cursor position wherever the mouse button is clicked on 
the screen.   

Navigation:  This shows the navigation position recorded in the raw data file.  The position is 
given in Latitude and Longitude, with the elongated button to the right for changing the 
format from DD MM SS, DD MM.MM, DD.DDDD. 

Ship:  Shows the ships speed in knots and the Gyro compass heading. 

Sensor Data:  Shows information related to the sensor including the following: 

·  Sonar Range (in meters) 

·  Pitch 

·  Roll 

·  Heading 

·  Speed 

·  Depth 

·  Altitude 

Cursor:  The 'Cursor' display remains blank during file playback until the waterfall window 
is clicked with the mouse button.  The following information regarding the position selected 
will populate the 'Cursor' information display: 

·  Time 

·  Date 

·  Channel 

·  Slant Range 

·  Latitude 

·  Longitude 

·  Ping 

·  Heading 

·  Depth 

·  Altitude 

·  Layback 

 
 

6.9.6 File Playback Options 
Viewing data in the sidescan waterfall viewer can be controlled by standard DVD player 
controls with the following control bar: 
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The four buttons on the left go backwards through the data file, the four on the right go 
forward through the data file and the button in the middle pauses file playback.  Button 
details are described below: 

 

Jump to beginning of data file 

 

Slow motion backwards playback 

 

Fast forward in reverse 

 

Reverse file playback 

 

Pause playback 

 

Play file forwards 

 

Fast forward file playback 

 

Slow motion file playback 

 

Jump to end of data file 

 

Another option for moving through the data file in the waterfall viewer is the slider bar above 
the playback controls as shown below: 

 

The number to the right of the slider bar indicates what ping number the file is at.  Dragging 
the slider allow the user to quickly move through the data file to a particular ping number.   

How the viewer handles the end of the file being played can be set in the 'End of File Options' 
corner of the waterfall window.  Options available are shown in the following image and 
discussed below: 
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Loop Back:  This option loops the file and restarts playback from the beginning of the data 
file. 

Play Next File In Time:  Selecting this will automatically switch to the next file in the time 
that is loaded into the project. 

Stop:  This option will stop playback at the end of the file. 

 

6.9.7 Waterfall Map – Link 

As the data is played back in the waterfall window, the position in the data file is displayed in 
the map view.  This is useful for correlating features seen in the waterfall view to the map 
display.   

The following image shows a scour feature in the sidescan waterfall data: 

 

To see where this feature exists in the project, a round green circle appears in the map view at 
the position along the data line currently being viewed in the waterfall viewer as shown 
below: 
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Conversely, it is also useful to correlate features seen in the map view with the waterfall view 
of the raw data.  Double-clicking on a sidescan navigation line in the map view will open the 
waterfall viewer and bring up the data for that location.  In the example above, the "pipper" 
shows cursor position along the data line currently being viewed in the waterfall viewer.  
However if the user wishes to see the feature in the adjacent line, the pipper can be dragged 
to the other navigation line in the map view and the waterfall viewer will refresh with the 
data from the line the pipper was placed on as shown below.  The first image shows the 
pipper in its "dragged to" location and the second image shows the waterfall data for the 
adjacent line from the new pipper location: 

 

 

6.10 Waterfall Tools 

6.10.1 Bottom Tracking 
Before a sidescan mosaic can be made, the sonar altitude must be known to properly remove 
the water column data from the results.  MosaicOne comes with a bottom tracking tool that 
allows a user to automatically generate the bottom track and save it for use during data 
processing.   

The following image shows a sidescan waterfall window with data that is not yet bottom 
tracked.      

 

The bottom track will show up in two ways.  First there will be a red line following the water 
bottom in the waterfall image which is not seen above.  Also, there will be altitude data 
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displayed in the 'Sensor Data' information.  Shown below is a 0.0 value for 'Altitude', 
indicating there is no bottom tracking information in the file. 

 

To start the bottom tracking tool, select the toolbar button  

  or the menu option as shown below: 

 

This launches the 'Bottom Track Tool' window as shown below: 

 

The data is viewed horizontally at the top of the window with bottom tracking and viewing 
options below. 

Shown in the image above are two tabs for adjusting settings.  The main tab is the 'Standard' 
tab.  A brief discussion of the options available in the 'Standard' tab is presented here. 
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Method:  Before making adjustments to the bottom tracking options, a method must be 
selected from the drop down list.  Available options are shown here: 

  

Amplitude - Uses the sharp change in the signal amplitude to detect the water 
bottom and determine the sonar altitude. 

Gradient - Uses the sharp change in the signal gradient to detect the water bottom 
and determine the sonar altitude. 

 Manual – The user manually selects the water bottom either by pressing the 
left mouse button and dragging while holding along the desired line, or by 
holding the 'Alt' key and single clicking along the desired track. 

Channel:  Users can select which of the available channels to use for bottom tracking.   

Auto Update XTF:  Selecting this will store the bottom tracking information directly in the 
raw data file instead of in the cache file. 

Filter Bottom Track:   Removes noise in calculated bottom track and smooths results. 

Level:  Only available for 'Amplitude' bottom tracking.  Sets the percent change in amplitude 
to target as the bottom reflection. 

Holdoff:  Sets the starting point for the 'Amplitude' and 'Gradient' method and allows the user 
to remove strong returns from near the sonar and noise in the water column. 

Delta:  Used to constrain the filter gate (make sure this is not set to 0!).   

Delta Sensitivity:  Sets the sensitivity of the filter gate for finer adjustments. 

ms/m:  Toggles between time and distance units.   

To see the results of the settings chosen, select the 'Compute' button. 

 

The other available tab is the 'Color' tab for adjusting the view.  Note that this does not affect 
the data or the mosaic and is only used to visually enhance the sidescan data in the bottom 
tracking tool window for better manual picking.  A brief discussion of the options available in 
the 'Color' tab is presented here. 
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Gamma: Gamma is a way of logarithmically compensating for low intensity pixels 
that may be present in some images. Sliding the bar to the right increases the 
gamma index for the image (maximum gamma = +10); sliding it to the left 
decreases it (minimum gamma = +0.10). The value +1.00 represents 
midpoint of the scale (no gamma). 

Brightness: Sliding the bar to the right brightens the image; sliding it to the left darkens 
it. When the bar is at the midpoint (+0%), the image has neutral brightness 
(no change in brightness). Range is -100% (dimmest) to +100% (brightest). 

Contrast: Sliding the bar to the right increases the image’s contrast; sliding it to the 
left decreases it. When the bar is at the midpoint (+0%), the image has 
neutral contrast (no change in contrast). Range is -100% (least contrast) to 
+100% (most contrast). 

 

Viewing options in the lower right portion of the window allow the user to toggle on/off the 
bottom tracking results; compress the sidescan file to fit in the window or playback controls 
to move through the data file if not compressed.  Options include: 

Show Bottom Track:  Toggles on and off the display of the bottom track line in the data 
view.   

Compress:  If selected, this will compress the entire sidescan data file to fit horizontally 
across the 'Bottom Tracking Tool' window.  If this is not selected, the window controls below 
the 'Compress' check box become available for stepping through the data file as shown 
below: 

Slider Bar - Sets the amount of overlap between steps. 

Playback Controls - Allows the user to move to the 
beginning of the file, step forward, step 
backwards, or go to the end of the data file. 

 

There are three final options in this window: 
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Clear: Removes bottom tracking results. 

Apply: Applies the bottom tracking results to the data file and writes the results to the 
cache file and if selected into the raw XTF file as well.  Selecting this option 
will close the 'Bottom Tracking Tool' window after the results have been 
applied. 

Cancel: Discards the results generated and closes the 'Bottom Tracking Tool' window. 

 

6.10.2 Slant Range Corrections 
Slant range corrections are designed to remove the distortions caused by the oblique focus of 
the sidescan transducer/receiver array.  In order to apply slant range corrections, the bottom 
must first be tracked to remove the water column.  �

The following image shows a sidescan waterfall window with data that is not yet slant range 
corrected.      

 

Shown in the image is the necessary red line indicating the line has been bottom tracked. 
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To apply the slant range corrections, select the toolbar button   

This will correct the waterfall image by removing the water column as shown below: 

 

 

6.10.3 Speed Corrections 
Speed corrections are designed to remove the distortions during file payback caused by 
fluctuations in survey speed during data acquisition.  To apply speed corrections to your data, 

select the toolbar button   

Applying speed corrections for data with large fluctuations in survey speed will greatly 
reduce along track smearing of data caused by incorrect beam spacing in the waterfall 
window. 

 

6.10.4 Waterfall Histogram 

The histogram window is a graphical representation of the imagery signal level in dB versus 
the occurrence of that dB within the image.   
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To open the histogram window for the waterfall viewer, select the toolbar button   

 

This window shows two overlapping histograms, one is the original histogram and the other 
represents the modified histogram based on the adjustments the user makes here.  Options in 
the histogram window include: 

Window Options:  The two square boxes along the bottom of the window act as nodes for 
manually adjusting the portion of the spectrum to be displayed.  The lower and upper dB 
bounds can be set by left-clicking on the node and dragging it while the mouse button is 
depressed.  When the mouse button is released the color map of the mosaic layer in the 
map view will automatically update. 

Color Legend:  The gray histogram is the spread of the actual data.  The green is the 
'contrast-stretched' histogram of the data as defined by the user selected min/max range of 
the data.  The green histogram will be the actual data within the user-defined limits spread 
out over the entire graph range (dB).   

Auto-Contrast:   During the construction of the mosaic the program uses the default settings 
to improve the initial appearance of the image, program defaults are Bias 0% and 
Threshold 1%.  The threshold setting determines where the upper and lower limits of the 
histogram are located, based on the threshold curve.  A higher Threshold setting will 
move the upper and lower limits closer together.  The Bias setting moves the upper and 
lower limits closer, but allows the user to ignore the histogram curve.  The defaults of 0% 
and 1% therefore should include almost all values in the image with very little clipping.  
Selecting Compute will apply the changes made to Bias and Threshold to the Histogram. 
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Reset:  Allows the user to return the histogram to the original spread that was set during 
creation of the image. 

6.10.5 Waterfall LUT 
The imagery color settings can be changed for the waterfall viewer by selecting the LUT 
toolbar button   

This will open the following window: 

Options available in the Color Settings window 
are: 

·  Gamma:  The gamma of an image is a 
measure of its contrast and brightness. By 
correcting the gamma, you can adjust these 
two elements in unison. 

·  Brightness:  The user to change the 
brightness of the image.  A positive 
number will correspond to a brighter 
image, and a negative number will 
correspond to a darker image. 

·  Contrast:  Allows the user to change the 
contrast of the image.  The contrast of an 
image is the difference in brightness 
between due adjacent pixels. 

·  Invert:  Checking the box next to invert, will invert the color scheme that is applied. 

The button next to the color bar opens the Gradient Manager shown below:  

 

In this dialog the user can change the Lutz table applied and the algorithm used in the 
application of the color spectrum.  The user may also invert the application of the color tables 
by checking the box next to Invert within this dialog. 
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6.10.6 Waterfall TVG  
A time-varying gain (TVG) function can be applied to the waterfall data by selecting the 
'TVG' toolbar button   

 

This will open the following window: 

 

The window shown above is set to apply TVG to 'All Channels'.  If the user wants to set the 
TVG separately per channel, select the 'Set to Individual Channels' option and the window 
will change to look like the following, with a separate TVG tab per channel: 
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The default TVG curve is set to be flat, as shown in the image above.  To change the TVG 
curve there are two options. 

��  Left mouse click anywhere in the TVG window and a node will be added at that spot. 

��  Left mouse click on an existing node and drag it to a new location by holding the 
mouse button down. 

The sidescan data in the waterfall viewer will automatically update as the TVG curve is 
changed to get instantaneous feedback of how the changed curve affects the data display. 

TVG options available in the 'TVG Settings' window are: 

Start At:   Sets where the TVG function starts. 

·  Transmit - Starts at the beginning of the transmission. 

·  First Return - Starts at the defined bottom track. 

+ / - Buttons:  These are to the left of the TVG curve window and adjusts the maximum 
gain for the TVG curve. 

 

After the TVG curve is defined, the user has the option to save the curve using the 'Save TVG 
Settings' button.  This will launch a browser window for choosing a name and file location 
for the TVG curve as shown: 
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This TVG settings file can be loaded for use on subsequent data files by selecting the 'Load 
TVG Settings' button.   

 

An example of the effect TVG can have is shown below.  The first image shows the original 
waterfall view.  The second image shows a capture of the TVG settings.  The third picture 
shows the waterfall view after the settings were applied. 
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6.10.7 Waterfall Targets 

Targets can be acquired from the waterfall viewer by selecting the 'Contacts' toolbar button  

 

The targeting module is described in detail in the TargetOne section of the help document in 
Section 7.1.�
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6.11 Interpretation Options 

6.11.1 Sidescan Blink Comparator 

To quickly compare two overlapping sidescan mosaic layers, the 'Blink Comparator' tool can 
be used.  The 'Blink Comparator' allows the user to quickly turn on/off a layer or can be set to 
cycle a layer on/off to help identify differences in the layers.   

To use the 'Blink Comparator' tool, right-click on the mosaic you wish to "Blink" (cycle on 
and off) and select 'Blink Comparator' from the menu options as shown below: 

 

 

Selecting the 'Blink Comparator' menu option, the following window will open: 

 

The options available in the 'Blink Comparator' include: 

Layer On:  This will turn the selected layer on in the file tree so the layer is displayed in the 
map view. 

Layer Off:  This will turn the selected layer off in the file tree so the layer is not displayed in 
the map view. 

Cycle:  This will turn the cycle the layer on and off in the map view at the user set frequency 
using the slider bar to the right the Cycle option. 

 

An example of the use of this tool is presented on the following page.  The top image is with 
the selected layer off so the user can see the layer underneath.  The next image shows the 
selected layer cycled on showing an object on the bottom surface that was not present in the 
previously collected data. 
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6.11.2 Sidescan Statistics 

The statistics that can be calculated from a sidescan mosaic layer include the following: 
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·  Allocated Coverage:  This is the number of square nautical miles which the tiles used 
to store the data in the DTM layer represent.   

·  Actual Coverage:  This is the number of square meters of the actual ensonified area.   

·  Total Lines:  This is the number of lines included and used in the creation of the DTM 
layer. 

·  Along-Track Distance:  This is the combined along-track distance of all lines included 
and used in the creation of the DTM layer. 

 

To use the 'Statistics' tool, right-click on the mosaic layer you wish to extract the statistics 
from and select 'Statistics' from the menu options as shown below: 

 

 

Selecting the 'Statistics' menu option, will calculate the statistics discussed above and display 
them as shown in the following window: 

 

 

6.11.3 Sidescan Mosaic Targets 
Targets can be acquired from the sidescan mosaic in the map view by selecting the 'Contacts' 

toolbar button   

The targeting module is described in detail in Section 7.1.�
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6.11.4 Sidescan Classification 
Bottom types can be classified in MosaicOne using the built-in classification module called 
SeaClass.  The classification process is described in detail in the SeaClass section of the help 
document in Section 8.1.�

 
 

7: TargetOne 

7.1 TargetOne Module 

TargetOne is an add-on to Perspective Map which allows users to select targets from sidescan 
waterfall data or from mosaics in the map view.  Options available in the TargetOne module 
are presented below. 

 
Settings 

Settings for TargetOne are found in the 'Contact' tab of the main application settings for 

Perspective.  Application settings can be accessed through the toolbar button  or by 
selecting 'Settings Info' from the View menu as shown below: 

 

Note that the file paths for the temporary and saved contacts in the TargetOne settings must 
be different, and they need to be set before targets can be selected.  The 'Contact' setting 
options available are described in detail in Section 3.6. 

 
Target Selection 

Targets can be acquired in Perspective Map from raw waterfall data and from the mosaic 
layers in the map view.   
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Waterfall Targets:  From the waterfall window in Perspective, targets can be selected for 
classification and saving in TargetOne.  Details on how to collect targets from the waterfall 
view are described in Section 7.2.1. 

Map Targets: From the Perspective map view, targets can be selected from features identified 
in the mosaics for classification and saving in TargetOne.  Details on how to collect targets 
from the map view are described in Section 7.2.2. 

 
 

7.2 Target Selection 

7.2.1 Waterfall Targets 

To select a target from the sidescan waterfall view, open a sidescan line in the waterfall 
viewer.  Before selecting a target, make sure the Contact settings are set either in the main 
Perspective window settings or from the settings tab in the waterfall window.   

 
Targets can be selected from the waterfall window while the window is scrolling or while it is 
paused.  To enter the target selection mode, select the 'Contact Generation' toolbar button:   

 

This will launch TargetOne and will set the cursor to target mode for acquiring targets from 
the waterfall window. 

 
To acquire a target, double-click in the waterfall window on the feature of interest.  This will 
capture an image of the selected target and transfer that image into the TargetOne window.   

 

7.2.2 Map View Targets 

To select a target from a sidescan mosaic in the map view, move the mosaic to the top of the 
file tree layer by using the 'Move Up' or 'Move to Top' options in the Imagery/Sidescan file 
tree layer as described in Section 1.3.7.1. 

 
Before selecting a target, make sure the Contact settings are set in the main Perspective 
window settings.   

 
Targets can be selected from the top visible mosaic layer in the map view.  To enter the target 

selection mode, select the 'Contact Generation' toolbar button:   

This will launch TargetOne and will set the cursor to target mode for acquiring targets from 
the map view window. 
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To acquire a target, double-click on the mosaic on the feature of interest.  This will capture an 
image of the selected target and transfer that image into the TargetOne window.  If multiple 
lines of data used to create the mosaic exist in the selected target location, then one image 
from each data line beneath the selected location will be captured and sent to the TargetOne 
window. 

 

7.3 TargetOne Application 

7.3.1 TargetOne Layout 
 

 
Main Window Regions 

 Image View  

Displays the captured image from the waterfall or mosaic.  There are two parts to this 
view, the large image view in the center of the window and the Overview Window in the 
upper left corner of the window. 
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Thumbnail View 

Displays a thumbnail for each image saved in TargetOne, with a scroll bar to access 
thumbnails from farther down the list than what can be viewed in this window. 

 Image Display Controls 

This allows the user to adjust the image display settings. 
 

 Status Windows 

Information regarding the cursor position, towfish position and target measurements are 
displayed here. 
 

 Status Bar 

Displays additional status information including image size in pixels, color scale, zoom 
level, etc.  

 

7.3.2 TargetOne Menu Options 

File Menu 

 
 

New Project:  Create a new Perspective Project. 

Open Project:  Open an existing Project (*.proj_xml). 

Save Project:  Save your current project (*.proj_xml). 

Save Project As:  Save project with new name (*.proj_xml). 

Import:  Primary import menu for recognized types.  This option can also be accessed 
through the standard window drag and drop. 

Export:  Export Geo TIFF and KML files. 

Page Setup:  Page setup for printing. 

Print:  Print the current project. 
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Quit:  Quit Perspective. 

 

 
File Menu 

 

Open... Open an existing contact file (*.con, *.tgt, *.tif, *.pcm). 

Find Opens a Contact Search Criteria window to search for contacts 
in project. 

Close Close the active contact file. 

Close All Closes all open contact files. 

Save Save the active contact file, asks what file types to save to. 

Save Image As... Save the active contact to specified image type. 

Save All Save all contact files open in TargetOne. 

Save All Images As... Save all contact files open in TargetOne to specified image 
type. 

Delete From Disk Delete active contacts from the hard disk. 

Delete All From Disk Delete all contacts in project folder from the hard disk. 

Print... Print the current contact. 

Print Setup... Opens the printer setup dialog. 

ASCII Report... Opens window for setting up and generating an ASCII report. 

Exit Quit TargetOne application. 

 
Edit Menu 

Copy Copy the selected item to clipboard. 

Paste Paste the selected item from clipboard. 

 
Tools Menu 
 

ELT... Launches 'Electronic Light Table' options for advanced 
image processing. 

Annotate... Opens a dialog to enter comments to be written into the 
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image tag (Tag 270). 

Classify... Opens a window for classifying the active target. 

Geocorrect... Corrects active target image for north up, instead of 
heading up. 

Configuration... Opens an application configuration settings window. 

Ramp Support... Gives options for applying a ramp file. 

Cursor Symbol Options for the cursor icon symbol. 

Cursor Color Options for changing the cursor color. 

Pan Image Changes the cursor to enable the user to pan in the main 
image window. 

Activate Measure 
Toolbar 

Must be selected to use image measurement tools. 

 
 
View Menu 
 

Fit Options for fitting the active contact to the image view. 

Overview Window Toggle on/off the image overview window. 

Status Bar Toggle on/off the status bar. 

Zoom Toolbar Toggle on/off the zoom toolbar. 

Measurement Toolbar Toggle on/off the measurement toolbar. 

Thumbnail Window Toggle on/off the thumbnail window. 

Tools Toolbar Toggle on/off the tools toolbar. 

Display Control Window Toggle on/off the display control window. 

Basic Cursor Status Window Toggle on/off the basic cursor status window. 

Advanced Cursor Status 
Window 

Toggle on/off the advanced cursor status window. 

Meter Bar Toggle on/off the image scale bar. 

Polygon Points Toggle on/off the polygon points when available. 
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Window Menu 
 

Cascade Overlaps all contact image windows. 

Tile Tiles all open contact images in main image display window. 

Arrange Allows the user to arrange contact images. 

 
 
Help Menu 
 

About TargetOne Show the about dialog box. 

Contents Show the help table of contents.  

 
 
 

7.3.3 TargetOne Toolbars 

Main Toolbar 

 

  

 

Open an existing contact file (*.con, *.tgt, *.tif, *.pcm) 

 

Save active contact file, asks what file types to save to 

 

Copy 

 

Paste 

 

Print 

? Help 

 
 

  

Zoom Toolbar 
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Zoom to "Fit to Window"  

  
Zoom in one level 

  
Zoom out on level 

  
Zoom to area 

  
Zoom to "Fit to Width" 

  
Zoom to "Fit to Height" 

  
Linear Zoom 

  
Cubic Zoom 

  
Pan Image 

  

 
  

Utility Toolbar 

 

  

  
Measurement Tool 

  
Electronic Light Table 

  
Geometrical Correction Parameters 

  
Annotate 

  
Add comments to TAG270 

  
Reverse Palette 

  
Object Detection 
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Measurement Toolbar 

 

  

  
Measure Distance 

  
Measure Object Echo-Shadow (tied) 

  
Measure Object Echo 

  
Measure Object Shadow 

  
Measure Object Length 

 
 

7.4 TargetOne Window 
 

7.4.1 TargetOne Window Regions 

TargetOne has five main regions for displaying imagery and information as described below.   

Image View:  This consists of two parts: the main view of the captured target and an 
overview window showing where on the image the main view is zoomed into. 

Thumbnail View:  Shows thumbnail images of the contacts saved in the current Perspective 
project. 

Image Display Controls:  Controls the display options of the captured image. 

Status Windows:  Primary display of image information. 

Status Bar:  In addition to the primary information display, there is a status bar of 
information at the base of the image view window.  
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8: SeaClass  

8.1 SeaClass Module 
SeaClass is an add-on to MosaicOne which allows users to classify sediment types based on a 
neural net training set created from bottom sample information and select points or other 
ground truth methods.   

Supported Formats 

·  .TMAP_MOZ (Perspective Sidescan mosaic) 

·  .DDS_VIF (Triton Map Visual Information File) 

·  .TIF (GeoTIFF) 

The procedure works with the above file formats and is the same for any of these file types.  

 

Classification Process 

Create Training Set:  Using known bottom types at discreet locations, the user can create the 
training set.  Details of the Create Training Set process are described in Section 8.2.�

Neural Net Training:  This process uses the training set created in the previous step to train 
the neural net.  Details of the Neural Net Training process are described in Section 8.4.�

Classify:  The neural net is used to determine the bottom type throughout the image or mosaic 
layer.  Details of the Classify process are described in Section 8.3.�

 

Available Options 

Edit Training Set:  Allows the user to edit a training set.  Details of the Edit Training Set 
process are described in Section 8.5. 

Quick Classify:  Allows users to get a preview of the classification results without having to 
create the classification grid.  Details of the Quick Classification process are described in 
Section 8.6. 

 

8.2 Create Training Set 

The first step in the classification process is to enter ground truth information in order to 
generate a set of data points to be used in the neural net training process.  This can originate 
from multiple sources including bottom grab samples, diver inspections and video surveys, 
and must include a location and bottom type information. 
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To create the training set, click on the toolbar button    or right-click on the Manual 
Training node in the SeaClass File Tree and select 'Create' as shown below: 

 

 

This will open the 'Create Training Set' window shown below: 

 

Options available on this page include: 

·  Training Set Name - Allows the user to give the training set a unique name. 

·  Sampling Grid Size - Sets the output resolution in meters.  If 'Custom' is selected, the 
value is entered in the 'Custom Grid Size' box below. 

Click 'Next' to advance to the next page. 

 

This page is for adding classes (bottom types) and has the following options as shown below: 



 

   

177 | P a g e   Februa ry 2011 
 

 

Options available on this page include: 

·  Add Class - Selecting this will open 
a dialog for entering the name of the 
class types to be used as shown here: 

 

 

Selecting 'OK' will open a 'Color' window to 
select the color to use for the entered bottom 
type as shown here: 

 

 

 

 

 

 

 

 

Selecting 'OK' will add the entered name to the 'Training Classes and Samples' 
field as shown here: 
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·  Recording Options - The three buttons shown below are provided for linking the 
selected class to the mosaic or GeoTiff values.   

 The left button is for recording.  Double-Click in the Perspective Map View on 
areas you want to use as samples for training the Neural Net.  Click on the middle 
pause button when you are done. 

Selecting the X button will remove the selected class points from the 'Training 
Classes and Samples' field. 

When finished adding classes and recording samples, the Edit & Classes window should look 
similar to the following image: 
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Sample points will appear in the map view in the colors chosen as shown in the example 
below: 

 

 

The training set points will automatically appear in the SeaClass 
file tree as shown: 

 

The SeaClass file tree is discussed in Section 1.3.3. 
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Click 'Next' to open a dialog to for naming the training set XML file as shown here: 

 

or click 'Finish' to close the Edit & Classes window without saving the training set to a XML 
file. 

8.3 Bottom Classification 

The last step in the classification process is to use the neural net to automatically classify an 
image or mosaic file.  To classify an image or mosaic, right-click on file in the 'Imagery' or 
'Background' file tree and select 'Classify' as shown below: 

 

This will open the 'SeaClass' window shown below: 
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Options in this window include: 

·  The drop down list contains all of the available neural nets. 

·  Select the layer to classify by clicking the checkbox next to the layer name. 

·  Cancel will close the SeaClass window and stop the classification process. 

·  OK will close the SeaClass window and will open a Save Classification Grid File 
window as shown below: 

 

Enter a file name and select Save.  This will start the classification process.  The following 
dialog is displayed during classification: 
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When the process is complete the results are overlain on the image in the map view as shown: 

 

 

8.4 Neural Net Training 
The second step in the classification process is to use the training set already created to train 
the neural net.  To train the neural net for automated image classification, right-click on the 
training set node in the 'SeaClass' file tree and select 'Train Neural Net' as shown below: 

 

 

 

 

 



 

   

183 | P a g e   Februa ry 2011 
 

This will open the 'Train Neural Net' window: 

 

 

To create a new neural net, click the 'Create' button which will open the following window: 
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Enter a file name and select 'Save'.  This will return you to the 'Train Neural Net' window 
shown below: 

 

Options available include: 

·  Create - Used to create a neural net for automated image classification. 

·  Back - Allows users to return to previous pages of wizard to change values entered. 

·  Finish - Select when done creating neural nets and setting parameters. 

·  Cancel - Quits the Train Neural Net wizard without saving values entered. 

 

8.5 Edit Classification 
It is quite likely that as more work is done in a survey area, more classes will need to be 
defined. The user must employ the Edit Training Set option to add more classes to a project. 

Right-Click  on the node Training Set 1 under Manual Training and select Edit Training 
Set... 



 

   

185 | P a g e   Februa ry 2011 
 

 

Click Add Class to add a new class name and color, then click as before to define the new 
class:  

 

The same .CNX file can be updated or a new one created, the classification can then be done 
with either of the available .CNX files. 
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8.6 Quick Classification 

As mentioned earlier, the creation of the Classification image can take some time.  It is worth 
noting that the actual classification of the image does not take very long.  There is a Tool Bar 
Button called Quick Classification ID that can be used to check if the Classification image 
will be what was expected BEFORE the actual image is created.  To activate the 'Quick 
Classify' button you must complete all steps up to the end of Training the Neural net.  Once 
the .CNX file has been generated, left clicking on the individual Neural Net in the tree view 
will activate the button. Modality > Quick Classification ID will also activate the button: 
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When the 'Quick Classify' button is activated the mouse cursor becomes a Query pointer; 
double clicking anywhere on the image briefly (3 secs) shows the current classification for 
that point in the image: 

 

 

  


